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This is the hardware warranty.
Warranty

Tektronix warrants that the product will be free from defectsin materials and workmanship for a period of three (3)
years from the date of original purchase from an authorized Tektronix distributor. If the product proves defective
during this warranty period, Tektronix, at its option, either will repair the defective product without charge for
parts and labor, or will provide a replacement in exchange for the defective product. Batteries are excluded from
this warranty. Parts, modules and replacement products used by Tektronix for warranty work may be new or
reconditioned to like new performance. All replaced parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period and make suitable arrangements for the performance of service. Customer shall be
responsible for packaging and shipping the defective product to the service center designated by Tektronix,
shipping charges prepaid, and with a copy of customer proof of purchase. Tektronix shall pay for the return of the
product to Customer if the shipment is to alocation within the country in which the Tektronix service center is
located. Customer shall be responsible for paying al shipping charges, duties, taxes, and any other charges for
products returned to any other locations.

Thiswarranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage
resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;
b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any damage
or malfunction caused by the use of hon-Tektronix supplies; or d) to service a product that has been modified or
integrated with other products when the effect of such modification or integration increases the time or difficulty
of servicing the product.

THISWARRANTY ISGIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE

AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THISWARRANTY.
TEKTRONIX AND ITSVENDORSWILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

[W16 — 15AUG04]



This is the software warranty.
Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on
the mediawill be free from defects in materials and workmanship for a period of three (3) months from the date of
shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will provide
areplacement in exchange for the defective medium. Except as to the media on which this software product is
furnished, this software product is provided “as is’ without warranty of any kind, either express or implied.
Tektronix does not warrant that the functions contained in this software product will meet Customer's requirements
or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and
workmanship within a reasonabl e time thereafter, Customer may terminate the license for this software product
and return this software product and any associated materials for credit or refund.

THISWARRANTY ISGIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITSVENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX' RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER'S
PAYMENT ISTHE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH
OF THISWARRANTY. TEKTRONIX AND ITSVENDORSWILL NOT BE LIABLE FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

[W9b — 15AUG04]
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Important safety information

Important safety information

This manual contains information and warnings that must be followed by the user
for safe operation and to keep the product in a safe condition.

To safely perform service on this product, additional information is provided at
the end of this section. (See page X, Service safety summary.)

General safety summary

To avoid fire or personal

viii

injury

Use the product only as specified. Review the following safety precautions to
avoid injury and prevent damage to this product or any products connected to it.
Carefully read al instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow
generally accepted safety proceduresin addition to the safety precautions specified
in this manual.

The product is designed to be used by trained personnel only.

Only gqualified personnel who are aware of the hazards involved should remove
the cover for repair, maintenance, or adjustment.

This product is not intended for detection of hazardous voltages.

While using this product, you may need to access other parts of alarger system.
Read the safety sections of the other component manuals for warnings and
cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system isthe
responsibility of the assembler of the system.

Use proper power cord. Use only the power cord specified for this product and
certified for the country of use.

Do not use the provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, make sure that the product is properly grounded.

Power disconnect. The power cord disconnects the product from the power
source. Seeinstructions for the location. Do not position the equipment so that it
is difficult to disconnect the power cord; it must remain accessible to the user at
all timesto alow for quick disconnection if needed.

TekSmartLab User Manual
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Use proper AC adapter. Use only the AC adapter specified for this product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

The measuring terminals on this product are not rated for connection to mains or
Category I, 11, or IV circuits.

Do not operate without covers. Do not operate this product with covers or panels
removed, or with the case open. Hazardous voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components
when power is present.

Do not operate with suspected failures. |f you suspect that there is damage to this
product, have it inspected by qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged
or operates incorrectly. If in doubt about safety of the product, turn it off and
disconnect the power cord. Clearly mark the product to prevent its further
operation.

Examine the exterior of the product before you useit. Look for cracks or missing
pieces.

Use only specified replacement parts.

Do not operate in wet/damp conditions. Be aware that condensation may occur if
aunit is moved from a cold to a warm environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean
the product.

Provide a safe working environment. Always place the product in alocation
convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads.
Improper or prolonged keyboard or pointer use may result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an
ergonomics professional to avoid stressinjuries.



Important safety information

Service safety summary

Terms in this manual

A

The Service safety summary section contains additional information required to
safely perform service on the product. Only qualified personnel should perform
service procedures. Read this Service safety summary and the General safety
summary before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this
product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect power. To avoid electric shock, switch off the product power and
disconnect the power cord from the mains power before removing any covers or
panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist
in this product. Disconnect power, remove battery (if applicable), and disconnect
test leads before removing protective panels, soldering, or replacing components.

These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
ininjury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.
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Symbols and terms on the product

These terms may appear on the product:

B DANGER indicates an injury hazard immediately accessible as you read
the marking.

m  WARNING indicates an injury hazard not immediately accessible as you
read the marking.

m  CAUTION indicates a hazard to property including the product.
When this symbol is marked on the product, be sure to consult the manual
to find out the nature of the potential hazards and any actions which have to

be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbol(s) may appear on the product:

AN\

CAUTION
Refer to Manual

TekSmartLab User Manual Xi



Compliance information

Compliance information

EMC compliance

Xii

EC Declaration of
Conformity - EMC

This section lists the EMC (electromagnetic compliance), safety, and
environmental standards with which the instrument complies.

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility.
Compliance was demonstrated to the following specifications as listed in the
Official Journal of the European Communities:

EN 61326-1 2006. EMC requirements for electrical equipment for measurement,
control, and laboratory use. 123

CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A
IEC 61000-4-2:2001. Electrostatic discharge immunity

IEC 61000-4-3:2002. RF electromagnetic field immunity

IEC 61000-4-4:2004. Electrical fast transient / burst immunity

IEC 61000-4-5:2001. Power line surge immunity

IEC 61000-4-6:2003. Conducted RF immunity

IEC 61000-4-11:2004. Voltage dips and interruptions immunity

EN 61000-3-2:2006. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European contact.

Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic
interference.

Emissions which exceed the levels required by this standard may occur when this equipment is connected to a
test object.

For compliance with the EMC standards listed here, high quality shielded interface cables should be used.

TekSmartLab User Manua



Compliance information

Australia / New Zealand
Declaration of
Conformity - EMC

Safety compliance

Equipment type

Pollution degree
descriptions

Pollution degree rating

TekSmartLab User Manual

Complies with the EMC provision of the Radiocommunications Act per the
following standard, in accordance with ACMA:

m  CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in
accordance with EN 61326-1:2006.

Australia / New Zealand contact.

Baker & McKenzie

Level 27, AMP Centre

50 Bridge Street

Sydney NSW 2000, Australia

This section lists other safety compliance information.

Test and measuring equipment.

A measure of the contaminants that could occur in the environment around
and within a product. Typically the internal environment inside a product is
considered to be the same as the external. Products should be used only in the
environment for which they are rated.

®  Pollution degree 1. No pollution or only dry, nonconductive pollution occurs.
Products in this category are generally encapsulated, hermetically sealed, or
located in clean rooms.

= Pollution degree 2. Normally only dry, nonconductive pollution occurs.
Occasionally atemporary conductivity that is caused by condensation must
be expected. Thislocation isatypical office/lhome environment. Temporary
condensation occurs only when the product is out of service.

= Pollution degree 3. Conductive pollution, or dry, nhonconductive pollution
that becomes conductive due to condensation. These are sheltered locations
where neither temperature nor humidity is controlled. The areais protected
from direct sunshine, rain, or direct wind.

®  Pollution degree 4. Pollution that generates persistent conductivity through
conductive dust, rain, or snow. Typical outdoor locations.

Pollution degree 2 (as defined in IEC 61010-1). Rated for indoor, dry location
use only.

Xiii



Compliance information

Environmental considerations

Product end-of-life
handling

Restriction of hazardous

Xiv

substances

This section provides information about the environmental impact of the product.

Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and
use of natural resources. The equipment may contain substances that could be
harmful to the environment or human health if improperly handled at the product’s
end of life. To avoid release of such substances into the environment and to
reduce the use of natural resources, we encourage you to recycle this product in
an appropriate system that will ensure that most of the materials are reused or

recycled appropriately.

This symbol indicates that this product complies with the applicable European
Union requirements according to Directives 2002/96/EC and 2006/66/EC
on waste electrical and electronic equipment (WEEE) and batteries. For

information about recycling options, check the Support/Service section of the
Tektronix Web site (www.tek.com).

This product is classified as an industrial monitoring and control instrument
accessory, and is not required to comply with the substance restrictions of the
recast RoHS Directive 2011/65/EU until July 22, 2017.

TekSmartLab User Manua



TBX3000A

Overview

This guide introduces the TBX3000A and provides a step by step demonstration
of how to use the product.

Packing list
Please confirm that you have received all the items listed in the packing list:
= The TBX300A
® 4 USB cables
= 1 power cable

m 1 DC power adaptor

Get acquainted with the TBX3000A

Main features =~ TBX3000A is used to connect Tektronix and Keithley products: oscilloscope,
signal generator, digital multimeter, and power supply.

= |tisequipped with USB 2.0 ports and RJ45 10/100M bps Ethernet port

® |t can be connected to WIFI after installing a USB WIFI dongle
(eg. TEK-USB-WIFI)

= |tispowered by a DC power adaptor (5V/3A)

TekSmartLab User Manual 1



TBX3000A

Appearance

DEVICE RESET

=N o e -
& B ° @
—1 —J

P

— i =
Figure 1: Side view 1 of TBX3000A

One side of TBX3000A has the following connectors, buttons, and indicators:

m  Ethernet LAN port: The TBX3000A is connected to the network through
this port.

m  USB device port: Theoriginal code of the product is burned through this port,
which is used by manufacturer only.

®  Reset button: If you press this button and hold down to 5 seconds, the SYS
indicator will blink rapidly for 5 seconds, then the default setting (including
password and |P parameters) will be restored.

®  DC power socket: Use this connector for the DC power supply that came
with your instrument.

-~

\ _________ T — —

=5 [S==5) 4 [anss) 2

—7 Nt

e U

Figure 2: Side view 2 of TBX3000A

The figure above shows another side of TBX3000A with six USB 2.0 ports. You
can connect TBX3000A to other instruments by USB cable.

TekSmartLab User Manua
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The figure below is the top view of the TBX3000A, showing the Tektronix logo
and indicators.
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Figure 3: Top view of TBX3000A

Thefirst six are USB indicators. If the indicator is on or blinking, it means
some instrument is connected to TBX3000A through a USB port.

The one next to the USB indicators is the WIFI indicator:

= If it'snot on, it means the USB WIFI dongleis not installed or the WIFI
dongle is not compatible with the instrument.

= If it blinks once at atime, it means the USB WIFI dongleisinstalled, but
TBX3000A is not connected to the WIFI.

= If it blinks twice a atime, it means the USB WIFI dongleisinstalled, and
TBX3000A is connected to the WIFI.

The last indicator is the system indicator (SYS):

= |If it blinks rhythmically, it means the power is on and the system is
functioning.

= If it'snot on, it means the power is not on or the system is malfunctioning.

= If it blinks unrhythmically, it means the firmware is upgrading.
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The figure below shows the bottom aspect of TBX3000A.
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Figure 4: Bottom view of TBX3000A

The part illustrated as 7 is a socket for USB WIFI dongle like TEK-USB-WIFI.

Configure the TBX3000A

When the TBX3000A is connected to the network, you can configure instrument
parameters. The default IP address for the instrument is 192.168.1.101. Enter the
default address into a web browser, press Enter, and the welcome page shown

below is displayed.

Welcome Page

Welcome Page W

LANG: Irvstrement Model. TEX30004,
Firmmware Rewvision: 200

WE} Conflouratan Serial Number- 010625

Set Password Iﬁannedmn Status: Connested
WIFI Connectien Status. Disconnected
Host Name (FQDN). Bench local,

Figure 5: Welcome page for TBX3000A configuration

The Welcome page shows the firmware version, serial number, LAN connection
status, WIFI connection status, and the hostname of the TBX3000A.

4 TekSmartLab User Manual
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LAN Configuration  Click LAN Configuration in the navigation bar on the left to show the LAN
Configuration page.

[P
Y LAN Configuration x
-~ C [} 192.1681.101 =
LAN Configuration
Welcome Page
Hostnama: Benchil
LAN Canflg
Deseniption TEXI000A
WIE Cotfiguratian TCPAP Configuration Mode Manual
Set Password IP Address. 192.166.1.101
Subnet Mask: 255,255 255.0
Diefault Gateway: 192 16811
Connect Status; Connected
Speed 100Mbs
Modify
Tektronix:
g

Figure 6: LAN Configuration

Click Modify to configure the LAN parameters and the host name.

The default LAN configuration values are shown below:

Host Name Bench 1
TCP/IP Configuration Mode Manual

IP Address 192.168.1.101
Subnet Mask 255.255.255.0
Default Gateway 192.168.1.1

TekSmartLab User Manual 5
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WIFI Configuration

Click WIFI Configuration in the navigation bar on the left to show the WIFI
Configuration page.

ok
" WIFI Conhiqurstion .
€« C [} 1921681101 =
WIFI Configuration
Welcome Page )
LANC Hostname: Bul:_!ﬂ
Dinseniption | TEX3000A
WIEI Configuration TCPAP Configueation Mode: Auta
Sot Password IP Address: 169.254,73.87
‘ Subnet Mask 255.255.0.0
Default Gateway: 192.168.1.1
| +
| SSID |
Connect Status: Disconnected
Signal Intensity
[ Modiey | [ scmar |
Teklron/l,x"

Figure 7: TBX3000A WIFI Configuration
Click Modify to configure WIFI network parameters.
Click Scan AP to search for the SSID of the WIFI network.

NOTE. The TBX3000A will connect to the WIFI network, only after the USB WIFI
dongle isinstalled on the instrument.

TekSmartLab User Manual
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Set Password

TekSmartLab User Manual

Click Set Password in the navigation bar on the left to change the password
for the instrument.

)
1] Administration x\

€& - ¢ [7192.168.1.101 ¥l =

Administration
LA"t.‘mngan ] l:‘.'hnqu_ﬁa.sm-&:
Wl Configuration
R Current Password:
“w ew Password:
Confims New Passwotd:
Submit
'Ibktmn}x“

Figure 8: Set Password

You can change the password on this page. The default password is admin.



TSL3000B installation

TSL3000B installation

Hardware and software requirements for the server

Hardware requirments

Software requirements

Installing TSL3000B

CPU: 2.3 GHz dual-core or higher

Memory: 4 GB DDR3 or higher

Display: Resolution of 1366 by 768 or higher
Storage: 160 GB or higher

Operating system: Win7 Professional, Enterprise, or Ultimate

.Net framework 4.5.2 and Visual C++ 2015 redistributable will be installed
automaticaly if they are not available on the computer.

Internet Information Service: 11S 6.0 or higher. For installation instructions,
please refer to 1S installation and configuration(See page 27, [1Sinstallation
and configuration.)

Database system: SQL Server 2014 Express or SQL Server 2014 Enterprise.
For installation instructions, please refer to Installing SQL server 2014 espress
(See page 9, Installing SQL server 2014 express.)

Visit www.tek.com, and search for ‘ TSL3000B’. Search through the results
and find the latest version of the software. Download and install the software,
following the software installation instructions on screen.

TekSmartLab User Manua
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Installing SQL server 2014 express

Downloading the  Visit http://www.microsoft.com/enin/
installation pack download/detail s.aspx?d=42299=rss _alldownloads devresources, and choose
the installation pack consistent with the bit number of your operation system.
For example;

m  For 64-bit Win7, choose ExpressAndTools
64BIT\SQLEXPRWT_x64_ENU.exe

m  For 32-bit Win7, choose ExpressAndTools
32BIT\SQLEXPRWT_x86_ENU.exe

NOTE. The size of the installation pack is around 800MB.

The installation cannot be carried out if the bit number of the installation pack is
not consistent with your operation system.

TekSmartLab User Manual 9
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Installing the software

10

In this procedure, we use the 64-bit Win7 installation package as the example.

This section explains how to install the database system.

1. Double-click SQLEXPRWT_x64 ENU.exe, and choose the directory for

extracted files. The following figure is displayed.

- TS
Microsoft SQL Server 2014 Express with Toals ot

Preparing: D:\5ca2536b768603c2ee92dde 2a 7 \redist \DotMe. ., \NDP40-KB2468871-V2.EXE

Figure 9: Extracting files

You may have to wait up to two minutes while the installer extracts the
TSL3000B installation files. Then the following figure is displayed.

= New SOI Server stand-alnne installatinn or add features tn an evisting installatinn
i
Installati ad Launcha wizard.tc_install sqL Sewerlql-l in a non-clustered environment or to add
Tealures Lu an exisling SQL Server 2014 instance,
Maintenance
Tk E Lipgrade from SO Server 2003, SQ1 Server 2008, SQL Server 2008 R? or SQL Server 2017
ocls >
Launch a wizard tc upgrade UL Server 2005, SQL Server J008, SQL Se-ver JUOE B2 or UL
Resources Server 2012 to SQL Server 2014,
Options
Microsoft SQL Server 2014

Figure 10: Installation center
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2. Click New SQL server stand-alone installation or add featuresto an
existing installation. The following figure is displayed.

| To install SQL Server 2014, you must accept the Microsoft Software License Terms.

License Terms -
Global Rules

‘| Microsoft Update MICROSOFT SQL SERVER 2014 EXPRESS

j[[Eicauc Upases These license terms are an ag Microsoft Corp (or based on where you
Install Setup Files live, one of its affiliates) and you. Please read them. They apply to the software named above,
Install Rules which includes the media on which you received it, if any. The terms also apply to any Microsoft

‘ Feature Selection . updates,

| Feature Rules

|| Feature Configuration Rules supplements, <
Installation P ,

ation rogress Y j

Complete Copy  Print

|._'"_ 1 gccept the license terms, I

= Ium on Customer Experience Improvement Program ("CEIP”) and Error Reporting to help improve the
! quality, reliability and performance of Microsoft SQL Server 2014,

he Micn r 2014 Priv. f inf ign.

* Microsoft SQL Server 2014 also includes a Visual Studio component that will have CEIP settings tumed
off by default. If Visual Studio is installed, this component will use the CEIP settings for Visual Studic.

—

< Back Mext > Cancel

Figure 11: License terms

3. Select | accept the license terms.

11
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12

correct.

Global Rules
Microsoft Update
Product Updates
Install Setup Files
Install Rules
Installation Type
License Termes
Fealure Seleclion
Feature Rules
Feature Configuration Rules
Installation Progress
Complete

If an update for SQL Server Setup is found and specified to be incluced, the update will be installed.
S —
Task Status 1

Scan for product updates | Completed

Download Setup files Skipped

_Er.lrm_l Setup files | Skipped

Install Setup files | Skipped

< Back Mext > Cancel

Scrver 2014 Sctup

Install Setup Files

4. Click Next. The program will check whether the files for installation are

Figure 12: Setup files check
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After verifying the files, the following figure is displayed.

-
 SGQL Server 2014 Setup

. e

solel)

Feature Selection

License Terns

Global Rules

Microsoft Lpdate
Product Updates
Install Setup Files
Install Rules

Feature Selection
Feature Rul=s

Instance Configuration

Server Confiquration

Select the Exprese features to install.

Leatures:

Databasc Engine Services
[#] SQL Server Replication

Shared Features

|¥| Client Tools Connectivity

[¥] Client Tools Backwards Compatibility

[¥] Client Tools SOK

[¥] Management Teols - Basic
Management Tonols - Complete
Q1 Client Connectivity SDE
[[] LecalDB

Engine ( g
Feature Configuration Rules
Installation Progress

Complete

Features

|| Select All lummm

Feature description:

The corfliguration and vperation of each
instance teature ot a SQL Server instance 15
isnlated from ather SQI Server instances. SOIL
Server instances can operate side by side on

Breveyuisites for selected features:

Alrcady installed:
i Windows PowerShell 2.0

Disk Space Reguirements

Drive C: 2535 MR required, 23218 MR availahle

Instance root directory: C\Program Files\Microsoft SO1 Server, !
Shared feature directory: C:\Program Files\Microsoft SQL Server)
Shared feature directory [x86): Ci\Program Files (86)\Microsoft SQL Server,

a

< Bark i

[ Mest > ” Cancel “ Help

Figure 13: Feature selection

5. Click Select All.

6. Click Next. The following figureis displayed.

# SO Server 2014 Setup

= ‘— " —

Licenss Terms

Global Rules

Mic rescll Upsdate
Product Updates
Install Setup Hies
Install Rules

Featur= Selection
Featurz Rules

Instance Configuration
Server Configaration

Featurz Confijuration Rules
Inctallztion Progrese

Lompcte

Instance Configuration

Database Frigne Configuration

Specify tie name and instance ID for the instance of SQL Server. Instance ID becomes part of the installation path

_) Hamedinstance: | NSSUOLSEHYVER

Instance ID: MSSUJLSERVER

SCL Server directory:  C\Program Files\Microsoft SQL Server\MSS50QL12 MSSGLSZRVER

Installed irstances:

Irstance Name Instance ID Featurzs

Editien Version

| « Back

[ext = | Cancel | [ Help

Figure 14: Instance configuration
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7. Select Default Instance.

8. Click Next. The following figure is displayed.

# SO Server 2014 Setup

-

F P ape—
o Pa——

Licenss Terms

Global Rules

Mic rescll Upsdate
Product Updates
Install Setup Hies
Install Rules

Featur= Selection
Featurs Rules
Inctance Configuration
Server Configuration

Featurz Confijuration Rules
Inctallztion Progrese

Lompcte

Server Configuration

Database Frigne Configuration

Specify the cenvice accounts and collation configuration.

Service Azcounts | Collation

Microsoft recommends that you usc a separate account for each SQL Server senice.

Startua Type

Service Aceount Name Pasownrd
SQL Sorver Database tngine M1 eraicc\MSSLSERVER i

1501 Sesves Rivwses |NT AUTHORITYAL OCAL ... |

Disabled |~

<Back || Mea> | Cancel

[

Figure 15: Server configuration

9. Click Next. The following figure is displayed.

# SOL Server 2014 Sctup

B

License Terms

Global Rules

Microsaft Upcdate
Product Updates
Install Setup Hiles
Install Rules

Feature Selection
Feature Rules

Instance Configuration
Server Configuration
Database Frugine Configs

Database Engine Configuration

Specify Databace Engine authentication security mode, administrators and data directories.

Senver C ion | Data | user HILES TREAM |

Specify the mede and tor the Engine.

ication Mode

(2 Winedows authentication mode

@ Mived Mode (S0 Server authentication and Windows allthmtiralﬁrm]l

Specify the password for the SQL Server system administrator {sa} account.

ﬁr ‘ ]
Confirm password:  ssssssssssssssel J

Feature Configuration Rules
Installatien Progress

Complcte

Specify SOL Server admini

GLODAL Ichend {Ichend)

b [ (G

‘.";IQL S‘:rvu a;im‘irﬁsu‘aiuls
have unrestricted access
tn the Natahase Engine.

Figure 16: Database engine configuration
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10. For authentication mode, select Mixed M ode.

11. Input the system administrator (sa) password “ TekSmartL ab2015”.

NOTE. This password is mandatory. Make surethat T, S and L are all uppercase.

12. Click Next. The following figure is displayed.

-
R —— 000 00 0 0 WL

Installation Progress

License Terms

Hlcbal hules — |

Microsott Update Install_SglSupport_Cput4_Action : CreateShortcuts. Creating shortcuts
Product Updates

Install Setup Files

Install Rules

Feature Selectinn

Feature Rules

Instance Configuration

Server Configuration

Database Engine Configuration
Feature Configuration Rules
Installation Progress
Complete

¥

-
.

Figure 17: Installation progress

While this figure is being displayed, the database system is being installed.
This typically takes about 10 to 20 minutes to complete.
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When complete, the following figure is displayed.

1 SOL Server 2014 Setup P > =
Complete
Your SQL Server 2014 installation completed successfully with product updates.
Licegse Tem: Information about the Setup operation or possible next steps:
Global Rules ?
Micronaft Upidate | Festure Status
e e & Management Tools - Complete Succeeded
I e @ Client Tools Connectivity Succeeded
Trestall Setug: Files 1 Client Tools SDK Succeeded
Install Rules & Client Tools Backwards Compatibility Succeeded
Feature Selection @ Management Tools  Basc Succeeded
Feature Rules {3 Natahase Fanine Serires Surceeded =
Instance Configuration
Server Configuration Details:
Databiase Frgine Configuration NHEviiD PO DOCTGEon 16 SAC SHeT
Feature Configuration Rules El
Installation Progress Only the components that you use to wew and manage the documentation for SUL Server have
o been installed. Dy default, the FHelp Viewer curnponent uses the onllne Ilbrafy After |nstai||nq
mplcte 501 Server, you can use the Help Libeary M. t to doc fo
your local rnm;:)tpr For mare information, see Use ermqnﬁ Haoks Online for 501 Server
I{rhlln flgos i link /2] inki0- 29957 8:2)
Summary log file has been saved to the following location:
CAP m Files\Micros 120 Bootstra) 120160607 J48\ Summary W-SHPD-
LCHEM3-1 20160607 133748 nt

Figure 18: Installation complete

13. Click Close.

The installation of the database system is complete.

TekSmartLab User Manual
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1. Select SQL Server 2014 Configuration Manager in the Start menu of
Windows, as shown in the following figure.

R T T

. Microsoft S0L Server 2014
a Download Micraseft SQL Server Cor
L SQL Server 2014 Import and Export C
L SQL Server 2014 Import and Export C
Uz 5QL Server 2014 Management Studic

. Analysis Services

Confinuration Tools
E_E SOL Server 2014 Configuration M
Em SUL server (014 Error and Usage
5 SQL Server 2014 Installation Cent
S SQL Server 2014 Reporting Servic

Figure 19: Select configuration manager
The path to this link is:

Start >> All Program >> Microsoft SQL Server 2014 >> Configuration Tools
>> SQL Server 2014 Configuration Manager

2. Inthe SQL Server Configuration Manager, click SQL Server Network
Configuration >> Protocols for MSSQL SERVER, and then right-click
TCP/IP inthe right panel as shown in the following figure.

Depending on the operating system, the SQL Server Network Configuration
link might be (32 bit) or (64 hit).

(s %4l Server Cenfiguration Ma

i Eile  dcvion Kiew  Help

L AR ERERY 7|

4B 0L Server Configuration Manager [Lecall Protecsl Mame Status
) S0k Slewe st A Shaced Memary  Enabled

T Named Pipes Disabled

TP Disabled

ik Configuration (32bi)
B 50U Native Client 1.0 Configuration B2bit)

B Prctocals for MSSQLSERVIR
b o e e o )

Figure 20: Enable TCP/IP protocol
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3. Select Enable in the pop-up menu.
The following figure is displayed after you enable TCF/IP.

5“‘#"‘;"“_
| B gcton oo i
||z 0 =H

4 501 Server Configuaation Manager (Lacal) Pretecol Name Status
L] 5L Senver Senvizes W sharrdMemory  Enabled

| L SO Serves Network Conlfiguration (326it)
B 5t Native Chent 11.0 Comfiguaation (26it) ﬁ“"u“m—
# § 50U Server Network Configuration

- Protocols for MSSQLSERVER
i & 500 Netwe Clent 110 Configuistion

Figure 21: TCP/IP protocol enabled
4. Click SQL Server Servicesin the left panel. The following figureis

T 5l Server Coniguaion Wanmge | mm— —— | e — lu|ﬂ
| Ble fcbon yoew Help [
e 2E=00048 |
ﬂﬁ_l!L\s = _lallwl\ianay«llvul} I raeme State Start Mode Log On A Proces 1]
[ SaL Server Sendces I Other [Boot, Syste_ NT AUTHORITYALO.. 0
Automatic MT Service\MESQL.. 6280

50U Server Network Configuration (32it)
& 50U Native Chent 11.0 Configuration (32bit)
a | 5L Serves Metwork Confruration
- Pretorals for MSEOLSERVER
8 50L Native CSent 110 Configuration

Uther (Boot, Systew.  NTAUTHORITY\NE.. 0

Figure 22: SQL server services
5. Click SQL Server (MSSQL SERVER) in the right panel.

6. Click @ in the toolbar to restart the SQL server service.

7. Close the window.

8. Click Start >> All Programs >> Microsoft SQL Server 2014 >> SQL Server
2014 Management Studio, as shown in the following figure.

I Microsoft Silverlight

Microseft SOL Server 2014

a Download Microsoft SQL Server Cor

L SQL Server 2014 Import and Export C

b SOL Server 2014 Import and Export C

Uz SOL Server 2014 Management Studi
. Analysis Services =

| Configuration Tools

| . Integration Services

Figure 23: Select SQL server management studio
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9. Inthe Connect to Server window, select Database Engine for Server type.
10. Select the name of the computer for Server name.

11. Select SQL Server Authentication for Authentication.

12. Enter sa for Login.

13. Enter TekSmartL ab2015 for Password, as shown in the following figure.

Microsoft SQL Server 2014

Server type: lIIat abaze Engzine

Server name: W-SHPD-LCHEN3-1

Authentication: ISQL Server Authentication

Login: sa
Pas=word: bk ok

Remember password

[ Connect ]I Cancel I[ Help JI Optionz »>

Figure 24: Connect to server

14. Click Connect to log in. The following figure is displayed.

Figure 25: Main screen

15. In the left panel, right-click Database.
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16. Select Restore Database from the popup menu, as shown in the following
figure.

%‘g Microsoft SQLSemer Management S_ti_ndin__—
Eiie" Edit !iewgehug I_oa[s Window ﬁletpl N
Pl (S e | NewQuey [ i | &
Object Explorer v 1 x
Connect> 4 4 = [ 3] 5

= [ W-SHPD-LCHENS-1 (SGL Server 12.0.20

- B3
e o MNew Datanase...
= [
= [ Sec Attach...
& [ Sen Restore Database...
g @ R
e I:2 = Feslure Fies and Filegroups...
= 3 Mal

Deploy Deta-tier Application...
Import Data-tier Application...

Start PowerShell

Reports

Refresh

Figure 26: Restore database

17. Enter TSL Database next to Database.

18. Select Device.

19. Select*...".

20. Click Add, as shown in the following figure.

s - |l
Sowns - ~
i = Takect Bt davinss | =7 f :
Spmai fy Wi bakey naiis wd its Jmralio fm pewr sevios ppratis I
Dpealiace: |
[ - rids =
b Burdo, gatin
e :
Eeitae 15 |
Fariza plini

Bl Lo sinie
Feoy gwm Cowporend Troe Govwer Citobay

Figure 27: Specify backup
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21. Find the file TSL Database.bak in one of the following directories:

TSLDatabse.bak

TSLDatabse.bak

For 64-bit Win7: C:

\Program Files (x86)\Tektronix\TekSmartL ab\

For 32-bit Win7: C:\Program Files\Tektronix\TekSmartLab\

NOTE. If you are not able to find the file, select All Files next to Files of type,
as shown in the following figure.

P
[ Lusate Backup File - W-SHPD-LCHENZ-1

Backup File location: C:\Progran Fi

Lles (x88)\Tektronix\Tekt [ |

#-{ 3 FPLive

F-_J 99Mailllugis

#-{ 1 Reference Assemblies
#H-3 Sogoulnput

» O3 appdate

|_JCourselib

4 ToanV1 awer
2 Tektronix
@) 3 AcbExpress
-3 TekSaar (Lab
13 appdata
anr=elah

F13 Log
-3 Eeport
[#-_4 Sl¥eb
- ¥ed
-3 wee
g e

’ g

File pame: TSLDatabase bak E}ium Files (¥ bak:® trn:% log =

Cancel

& dlf

ax

Figure 28: Change file type
22. Click OK after you find the file, and the following figure is displayed.

fowsce
Deane
S 3 i) b e e
[TV |
Spakily ths b Sals ihd At Liwtion [0 o Saltins ST
Cirdwanon
Datstase ST o Te -
Bt E- —
i ST
Pattd plan — =
Eaghup sty taramore [
Fesow  Vame  Compal — | T
[

Figure 29: Backup file found
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23. Select the file using the checkbox in the Restor e column, and then click OK.
The following figure is displayed.

1= Restors Databace - TiLDutabare L= | O
0 Featy

il 1 a pagr 5 seript = | [CyHelp
& Gruenal

2 Files
& Optocns

& Ogace: C\Pregearm Fies BBE]) Tebteonn TebSrmartl sb\ TS Distsbase bak

Dmstase T Dalalrase

Datapase: TS Dt

Bestoee to: Tise lact backup taken (Mondy, May 13, 2018 121741 B Iemedine.

Connection
&) WSHPDALCHEN: [1a]

Vigsh SONNECTION proparie
- {i W 0 |

") Dane =

oc ][ comes [ vy

Figure 30: Select the most recent database

24. Click OK to complete the configuration and a confirmation message is
displayed, as shown in the following figure.

F B
Microsoft SQL Server Management Studic ﬁ

Iﬂl Database T5LDatabase' restored successfully.

5

Figure 31: Database configuration complete

NOTE. If you had installed SQL Server 2008 R2 Express and restored the
TSLDatabase.bak before, select Options and then select Overwrite the existing
database (WITH REPLACE) as below before restoring the file.
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[t bactupios incont o ba eserne
- Sscr - | [Hde

]
re

Faitae gt
= Opsern |
(2 ovmtnne camg s i rinsce,

1 Preerve the e e setlge (WITH KEEP_REPLICATICN)
7 Rt moe e e s detabot (RTTH RESTRICTED USER)

paceny (Amose oy o)
Sy fle:

oo backp
Tobe tad-log beckap before ettt

Backug fie:
S o
it Chene exsting commectioe 16 detination delsteie
B W-BETACHINGS faa]

Prgeg s estiindy abiR bbikg

Figure 32: Overwrite the existing database
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Adding Inbound Rules 1. Open thefirewall setting screen by navigating to Start >> Control Panel >>
System and Security >> Windows Firewall >> Advanced Setting'.

2. Double click Inbound Rules and then right-click it to display the pop-up
menul.

3. Select New Rule..., as shown in the following figure.

d '
b '
sy
R
" ey '
™ say poy o
o Bey rov s
- b ey oy y n
10 tibinnbing Rats St FCWI A W ey hep Ay ®
B8 e - | mestama Fegaest JCME.. aew  Me By 2oy 2 K
1 samionon weo e s b i oy T
- PP oy Ay L
Aew Mo by sy T
anw  me ey aay
P by oy
Figure 33: Create new rule
4, Select Port, and click Next.
& New Inbound Rule Wizard X
Rule Type
Select the type of firewall rule to create.
Steps:
» Rule Type What type of rule would you like to create?
@ Protocol and Ports
@ Action () Program
@ Profile Rule that controls connections for a program.
@ Name ® Port
Rule that controls connections for a TCP or UDP port
() Predefined:
AllJoyn Router
Rule that controls connections for 8 Windows experience
) Custom
Custom rule.
< Back Nexd Cancel

Figure 34: Select port
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5. Select TCP, select special local portsand input 1433, then click Next..

WP New Inbound Rule Wiza X
Protocol and Ports
Specify the protocols and ports to which this rule applies.

Steps:

& Rl Type Does this e apply to TCP or UDP?
@ Protocol and Ports @® TCP

@ Adion O upp

@ Profile

@ Name

Does this nle apply to alllocal ports or specific local ports?

) All local ports
@® Specific local ports: 1433
Example: 80, 443, 5000-5010

<Back Next > Cancel

Figure 35: Allow the connection

6. Select al the options and click Next.

@ New Inbound Rule Wizard ®

Profile
Specify the profiles for which this rule spplies

Steps

@ FRule Type When does this ule apply?
@ Protocol and Ports
@ Adtion Domain

Applies when a computeris connected to ts corporate domain.

& Profile
@ Name Private
Applies when a computer is connected to a private network location. such as a home
ar work place
Public

Applies when 3 computer is comnected to @ public network location.

< Back Next > Cancel

Figure 36: Profile
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7. . Input aName, for example TSLSQL, and click Finish.

B New Inbound Rule Wizard ®
Name

Specfy the name and description of this e

Steps:

@ Rule Type
@ Protocol and Ports

@ Action

@ Profe Bane
[Tsisadf

@ Name

Description (optional)

<Back Cancel

Figure 37: Input name
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IIS installation and configuration

Installing IIS in Win7 1. Click Start >> Control Panel >> Programs >> Turn Windows features on or
off, and then select I nternet I nfor mation Services as shown in the following
figure.

— e — __|
@K‘,J'IE Q.::m- f ’M‘;_\N“) v |4 || ==

Contrel Panel Home

System and Secuity K uniots

Network and Interret ¢ =TS

Hardware and Sound == |
| :

* Programs ult Turn Windows features on or off @
User Accoumts EJ Desktop Gadgets ;:xnam:fhm,tmumm.mmnmmﬁ,m chedk bax. & ool part
Appearance and " Add gadaets ta the def % oz
Fersonslizition Mestore desitop gadgd | @ Games
Clock. Langusge. and Region 1), Irubesing Service
S e t FreeFall Data Prof L_FL4 Inberet Explore 8

: = W ). Intemet Information Services
- foi FIF Server
| & Java (32-bit) 5 ML web et Tooks

W | word wide Web Sernees
B || Appkeaton Development Featres
vd JNET Extensibiity
L AsP

¥l ) Ase.NET
vk csl
7]} 15AP] Extensions
7 4 ey Fiters

¥ Serverside Indudes

o Wl | Commen HTTP Feahres
9 [l | Health and Diagneatics
# M | Performance Features
% W) Seasily

I L0 el T maton Serves Fosiaoe ey Core

Mechs Features

Microsoft NET Framework 3.5.1

Mcrosoft Message Queve (MM) Server

it and Danument Servces

femate Differential Cempreasion

femote Server Adminatrabon Tools

AIP Listener

| = Services for NP5 £

HEECEE

Figure 38: Select internet information services

NOTE. If you areinstalling I1Sfor the first time, make sure that you follow the
instructions above.

2. Browseto World Wide Web Services >> Application Development Features,
and then select the following:

= .NET Extensibility
= ASPNET

= CGl

= |SAP Extensions
= |SAP Filters

= Server-Side Includes
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3. Browse to World Wide Web Services >> Common HTTP Features, and select
the following

Default Document
Directory Browsing
HTTP Errors
HTTP Redirection
Static Content

4. Click OK.

NOTE. Make sure that WWeb Management Tools is selected by default.

After afew minutes, the installation will finish.

Installing IIS for web server 1. Open the Internet Information Services (I11S) Manager on your computer
one of the following two ways:

Click Start, and enter 11S in the search box. Then open the Internet
Information Services (11S) Manager from the search results.

Right-click Computer, and then select Manage. You can find I nter net
Information Services (11S) Manager under Services and Applications,
as shown in the following figure.

EET open

[.'_'1 Manage

& TortoiseSVN v

Map network drive...
Disconnect network drive...

Create shortout
Delete
Rename

Properties

Figure 39: Open internet information services manager
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2. Collapse the items in the left panel.
3. Under Sites, select Default Web Site.

4. Click Stop under Manage Web Site in the right panel, as shown in the
following figure.

Y Intermet Information Services (115) Manager o[B8
@U | @) » WSHPDBYANL » Sites » DefoultWebSte » R T
He Wiew Help
Connections
|,, ] @ Default Web Site Home
4 N3 \W-SHPO-BYAN1 (GLOBAL \oyant) = o =
L) Applcation Pooks Fiter: = fiGe - ymShow Al |Grouoby: Area - =
%) Defaudt Web Site 8 . — = P <4 3
8 £ @ @ F B 8 & = [
NET T NET Brror NET MNETPofle  METRoles  NETTrust  NETUsers  Apphcation  Conmection
Authorizali...  Complation Pages  Globalzation Level Settngs Strings
K =g .
Machine ey Pagesand  Froviders  SessonState  SMTP E-mad
Centrols
s
e &7 5 e rm BB —~
& g ¢+ B B & & 3 W
=1 [ Default Dvectory  EmorPages  Mander HT® 15APIFilters  Logoing
Detument Hrowsng Mapongs Respo,
- 3 Ja ="
= oM o = §
MIME Types  Mocudes: Ouput Request 550 Settings e
Cadig  Fiterg 2
Management
=
Configur ation
Editor
[resare v J & corsen v
Ready b

Figure 40: Internet Information Services (lIS) manager
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5. Right-click Sites and select Add Web Site..., as shown in the following
figure.

- Bl '@.ﬂ’ A Gropby: 1o Set Web Site Dafaults....

Status Bdng Path ®
5 Oriine Help
Stopped (... *:80 (http) HiSystemDrive Yelinetpublinnroot

31 PM

T 2015

Figure 41: Add a web site
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6. Enter SLWeb under Site name.

7. Under Physical Path, select one of the two directories for the SLWeb file.
= For 64-bit: C:\Program Files (x86)\Tektronix\TekSmartL ab\SLWeb
= For 32-hit: C:\Program Files\Tektronix\TekSmartL ab\SLWeb

8. Click OK, as shown in the following figure, to finish.

2dd Web Site (2] = |

Site name:
Centent Directory
Fhysical path:

<rogram Files\ektreniA TekSmartLaE\SLWED > | ., |

Fass-through authentication

l Connect as... ] ’Te;t Settings... ]

Binding
Type: IP address: Porz
http | All Unassigned - &0
Host name:

Example: www.contosa.com or merketing.contose.com

[7] Start Web site immediately

[ ok || concel

Figure 42: Select the SLWeb file
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Configuring ASP.NET 4.0

1. OpenInternet Information Services (I11S) Manager as described before.

2. Select the server namein the left panel (highlighted in the following figure).

=181%]
[ = A1 -

W Internet Information Services (T15) Manager

6‘@ | %5 + waenavan

He Yew Heb

;_ @) W-SHPD-BYAN1 Home
= . Hiters - Moo - Fishewsd |Grownby: ares - [ ": Hesint
i start
-l Sites ASPNET =
14 G Defadt web Sae : G 2 e
-6 sLwed za ,‘_1/.- L s % =| :t- ﬁ i—] é} Vi Agpdcaton Pooks
; - = ‘ (@ =) [ EE-T | :
T el T Error HET METTrust  Apphcabon  Conneclon  Machnekey  Pagesand  Provders e
Authorizati.. Compdaton  Pages  Globshaaben Levels Settngs Stngs Contrals Chanae HET Froméwork Vet
g'i @l @ e
e Uik Help
Session State  SMTP Fmal
ns
1 h =3 ‘rul el = [
B+ & 9 o m @E €& @& &£
Authenticaten  CGE Compeesson  Defoult  Ovectory  ErvorPoges  Fostcul Hander HITR
Decument Growsng Settings. Mapongs Hespo... §| Restncbons |
Z g anlh F P £
6 Ei i q;."ﬂ F o = Lo n’!
ISAPIFiters  logging  MIMETypes  Modides Outpust Request Serve: Worker
Caching Fiterng  Cortificates  Processes
Management
[ 3 ==
B & B
Configurabon  Feature Shared
Editor Delegaton  Canfiguration
| | Fratues vew | Content view
Ready %

Figure 43: IS manager

32

3. Double-click ISAPI and GGI Restrictionsin the middle panel.
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4. Right-click the two ASPNET 4.0 entries to change the restriction to be
Allowed, as shown in the following figure.

" Internet Information Services (115) Manager o [=] 5
m | 95 v westPDBYAND ¥ [ e -

He  View  Help

— @3 I5API and CGI Restrictions _w
{293 WSHPDHYANT (5 ORAL yanT i icalL
3 B Aochcat r&* By Use this feature to specify the ISAPL and CGI extensions that can run on the Web server. Allow
Bl Sites Groupby: Mo Grouping " Frt..
&) Detault Web Site - | i X remove
m @ sLwech L >
ASF.NET V2.0.50727 N S VICTOSDT_NF | rAmeswnrkna\y 2 (0. 50 72/ \Anet_tsai_dl Edil Fealure Sellings...
Yiwindir W Microsoft.NET{Frameworkiv2.0. 50727 \aspnet_isapi.dil e Help
£y 1 winrk w4, (1. 213 19 t | 3
Add... bworkE4lv4.0.3031%aspnet_isapi.c Sl e
[ Mow |
Cdit...
x Remove
Edit Feature Settings...
@ ren
il Onine Help — I |
e v [ i
Configuration: ocalhost! applicationHst.confiy 9

Figure 44: Allow ASP .NET 4.0

After you've changed the status of the two entries, the following figure is
displayed.

“E Internet Information Services (IIS) Manager
@—@ [ € » wsosran: »

Fle View Help

-85 W-SHPD-BYAN1 (GLOBAL \pyan1)
(2} Application Pools

ﬁ;, ISAPI and CGI Restrictions

Use this feature to spedfy the ISAFT and CGI extensions that can run on the Web server.

E--E Sites Group by: Mo Grouping 7
- Default Web Site = P
€ sLweb L | Resiicton | Fath
iASP.NET v2.0.50727 Allowed Sowindir 3o \Microsoft. MET \Frameworké4\v 2.0. 5072 7\aspnet_isapi. dil

Sewindir e \Microsoft. MET \Frameworkv 2.0. 50727 \aspnet_isapi.dll
Ci\WindowsMicrosoft.NET\Framewarkv4.0,30319\aspnet_isapi.di
Ci\WindowsMicrosoft.NET\Framewarks4w4.0.30319\aspnet_isapi.dll

ASP.MET v4.0.30319 Allowed
ASP.MET v4.0.30319 Allowed

Figure 45: ASP .NET 4.0 allowed
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Ele View Help

-2} Application Pools
B8] Sites

-

,-'ﬁlnternet Information Services (IIS) Manager =10 ll
@i;,,, [33 } W-SPD-BYANL b | 5@ -
@gl ISAPI and CGI Restrictions =
ke
=¥ W-5HPD-BYAN1 (GLOBAL\byan1) .
a Use this feature to spedify the ISAPI and CGI extensions that can run on the Web server, Edit Feature Settings...
Group by: Mo Grouping - @ teb
(+-4a) Default Web Site i
& % wa:h = Description | Restriction | Path Orline Help
ASP.NET v2.0.50727 Allowed Sawindir Y \Microsoft.MET Framework64'y 2.0, 50727 \aspnet_isapi.dll
ASP.NET w2.0.50727 Allowed Sewindir Yo \WMicrosoft. NET Framework v 2.0, 50727 \aspnet_isapi.dll
< | ol
[ Features View |, - Content View
Configuration: ‘localhost’ applicationHost.config ej_:;

Figure 46: ASP .NET v4.0 not found

NOTE. Under some conditions, you may not be able to find ASP.NET v4.0, as
shown in the following figure.

In this case, you can solve the problem by using a DOS command (as
administrator).

a. Under Start >> All Programs >>Accessories, right-click Command
Prompt.

b. Select Run as administrator.
c. Enter one of the following commands in the window:
= For 64-bit Win7:
C:\Windows\Microsoft. NET\Framework64\v4.0.30319\aspnet_regiis.exe—i
= For 32-bit Win7:
C:\Windows\Microsoft. NET\Framework\v4.0.30319\aspnet_regiis.exe—i

You can aso copy and paste the command in the window, as shown in the
following
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[&+] Administrator: Command Prompt

Microsoft Windows [Uersion 6.1.76811
Copyright (c> 2809 Microzoft Corporation. All rights reserved.

C:“\WINDOWS \system32)>

Select All
Scroll
Find...

Figure 47: Paste command by right key

After you enter the command, the following figure is displayed.

&, Administrator: Command Prompt

Microsoft Windows [Version 6.1.76811]
Copyright (c> 2809 Microsoft Corporation. All rights reserved.

C:SWINDOWS ~system32>C:“Windows "Microsof t .MNET “Frameworkb4 w4 . 8.38317vaspnet_regii)
s.exe —1

Figure 48: Command window after entering the command
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Press Enter to run the command, the following figure is displayed.

dministrator: Command Prompt

icrosoft Windows [Version 6.1.76611
Copyright <(c?> 2889 Microsoft Corporation. All rights reserved.

C:SWINDOWS Nsystemn32 >C: “Windows \Microsoft .NET “Framewvorkb64 w4.8.30317vaspnet_regii)
s.exe —1

Microsoft (R> ASP.NET RegllI§ version 4.8.38319.1792%

Administration utility to install and wuninstall ASP.HET on the local machine.
Copyright (C> Microsoft Corporation. All rights reserved.

Start installing ASP.NET <{4.8.38319.17929%9>.

Finished installing ASP.MET <(4.0.30319.17929>.

C:“\WINDOWS\system32>

Figure 49: Result of the command running

Asshown in the figure, ASPNET v4.0 isinstalled. You should now be able to
configure ASPNET v4.0 according to the procedures described in this section.
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Configuring ASP.Net State

Server

the following figure.

1. On the desktop, right-click Computer.

2. Select Manage. The Computer Management screen is displayed, as shown in

-ioix]
File Acton View Help
e 2@l qo]@m s euon
w Computer Management (Local
B [
& (D Task Scheduler ASP.NET State Service Name = | Description | Statws | StartupType | logonas |
8 @ Event Viewer .+ Application Layer Gateway Service Provides s. . Manual Local Service
@ @] SharedFoders Start the service S Applic Mapag, e v . stem
H _-&\ LUc:IjUsErs and Groups — e
[ (%) Performance :
% Device Manager Description: - ) . Tocal System Hore Actions '
B 2 storage Provides support for out-of-process 4 Ea@round Inbel!lgentTransfer ... Transfersf.. Started Automat!c {D.. Local System
29 Disk Management sess?on .stabes for ASP.MET, If this - baidupcsuiteservice.exe Started Automatic Local System
B Services and Appiications service is stopped, out-of-proczss _ £, Base Filtering Engine The Base F .. Started Automatic Local Service
Wi ssmation Sery | FEIHEsts ";‘" nto‘tse pr°cess?d'};ﬁ“s ., BDHY Service BEYTE.,.  Started Automatic Local System
Zig;éi;sd:pzns U’j:‘f;\;r;r;’st;il ., BDKVRTP Serviee IAARRIA. Automatic Local System
=0 T CoTTo 4 BDMRTP Service BERT. Automatic Local System
B 5QL Server Configuration 4 BDSGRTP Service BEEZE. Automatic Local System
£+ BitLocker Drive Encryption Service  BDESVC ho .. Manual Local System
f+;Block Level Backup Engine Service  The WBEN... Manual Local System
{+;Bluetooth Suppert Service The Blueto... Started Manual Local Service
£+ Bonjour Service Enables ha... Started Automatic Local System
% BranchCache This servic... Manual Network 5...
‘. Certificate Propagation Copies use... Started Automatic Local System
4 Cisco AnyConnect Secure Mabilit... Cisco AnyC... Started Automatic Local System
4 CNG Key Isolation The CNG k...  Started Manual Local System
£+, COM+ Event System Supports 5. Started Automatic Local Service
4, COM+ System Application Manages t... Started Automatic Local System
£ Computer Browser Maintains a... Started Manual Local System
4 ConfigMgr Task Sequence Agent  ConfigMar ... Manual Local System
f+ Configuration Manager Remote .. Provides th... Started Automatic (0. Local System
£+ Credential Manager Provides s. . Manual Local System
‘. Credential Vault Host Contral Ser... HostContr... Started Automatic Local System
£, Credential Vault Host Storage Host Stora...  Started Automatic Local System
4 Cryptographic Services Provides fo... Started Automatic Metwork 5...
£, DCOM Server Process Launcher The DCOM... Started Automatic Local System
S Defary Started Automatic Local System
£+ Desktop Window Manager Sessio... ProvidesD... Started Automatic Local System
5+ DHCP Client Registers a... Started Automatic Local Service ﬂ
4 | 21N Extended A Standard Vi
|

Figure 50: Computer management

3. Select Computer Management (Local) >> Services and Applications >>

Services.

4. Select ASP.Net State Servicein the right panel to confirm that the statusis

‘Started’ and Startup Typeis ‘ Automatic’.
If not, change them by following these steps.
1. Right-click ASP.Net State Service.
2. Select Start or Restart.
3. Double-click ASP.Net State Service.

TekSmartLab User Manual 37



TSL3000B installation

4. Change the Startup Type to Automatic, as shown in the following figure.

ﬂ Computer Management

Fle Acton WView Help

2w = Blmle mnp

E Computer Management (Local)
0 [f} System Tooks
i (D) Tck Schaduer

= [{a] Event Viewer FERNEL e Sevce
@ ] Shared Folders ;
Start the service
i+ ¥ local sersand Groups | <
& (%) Performance
#4 Device Manager Drescription:

Provides support for out-of process
seasion states for ASPNFT. TF this
service is stopped, out-of-process
requests will not be processed, If this
service is disahled, any services that

exghicitly depered onitwil bl losterl,

£ {3 Storage

=4 Disk Management

Services and Applications

& W} Internet Information Serv
& WMI Control

3] 50U server Configuration

m

I Status 5 1

Name -~ un As
"4 Apphcation Host Helper Service Frowdesa...  Started Automanc Local System
4 Apphcaton identty Determines... Manual Local Service
(4 Appkcanon Informabon racitates ... Started  Manual Local System
% Apphcation Laver Gateway Service  Prowdes s... Manual Local Service
4 Apphcation Management Processes ... manual Local System
4, ASP.NET State Service Provides s... Manual Network s, .
54 Audio Service Managesa... Started  Automatc Local System
R 59 1T State Servce Propertie (| ocal Compater) ST
"4 bardupcsu m
: ase piter | General | Log On | Recovery | Dependencis | te
(o BOHY Sery m
G sy of [fESenacs riama: - akpnat Rtabn im
CABDMKIFS  Displayname:  ASP NFT State Service m
o BOSGHRITF ¢ T et m
Citatodkerl  Description: F;;ﬂht;i’nﬁ: or out sﬂmm j :
Path Lo exsculable. 5
CAWINDOWS! Microsoft NCT\Framework G4'w4.0.3031Paspnet_stote.exe | [™
m
m
m
e
m
Start | el | Hause i Hiestme "
m
‘You can specify the start parameters that apply when you star the service m
from here m
m
Stort parametera: I Im
m

Y
[

i

Extended

oK Cx!ndl.l‘aplyl

Figure 51: Configure ASP .Net State Service

5. Click OK to complete the setting.

6. Close the Computer Management screen.
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Windows firewall
configuration

You can open the firewall setting screen by navigating to Start >> Control Panel
>> System and Security >> Windows Firewall >> Advanced Setting'.

Adding inbound rules.

1. Double click Inbound Rules and then right-click it to display the pop-up
menu.

2. Select New Rule..., as shown in the following figure.

* Windows Firewall with Advanced Security 1ol x|
File Action View Help
ke A e N
ws Firewall with Advanced 5 TR = I ACBO
Profie m Inbound Rules -
Cutbound Ru
= WLLUSERSPROFILE %6 \Application Data\Input ... Daomain d New Rule
nle . ALLUSERSPROFILE % \Application Data\Input ... Domain ~ Yes Allow
F!Iber by State ¥ | op 0GRAMFILES%%\Products\Input Processer... Domain ~ Yes allow 7 Filter by Profle 4
Fiter by Group lPROGRAMFILES %\Products\Input Processor .. Domain ~ Yes Allow T Filter by State »
POECDDA Public Yes Allow
\iew L3 .
OO ACDDA Publiz  Yes Allow ' Filter by Group ’
Refresh B0 £ODDE UDP Port Publz  Yes Allow View >
Export List.... -Zip File Manager Domain ~ Yes Allow 3 Refresh
Help -Zip File Manager Domain ~ Yes Allow Ly Relres
reregilent Communications Fabric All Yes Allow |i= ExportList...
@Agllent{lonnecﬁonExpert All . Yes Allow Help
@ba\dubrowser.exe Domain ~ Yes Allow
@ba\dubrowser.exe Publiz ‘es Allow
baidubrowser.exe Domain  Yes Allow
baidubrowser.exe Publiz es Allow
@ba\duhmwser.exe Privete  Yes Allow
baidubrowser.exe Privete  Yes Allow
@BDAIEddinAssismnt Publiz ‘es Allow
@BDAIaddlnAsslsmnt Publiz Yes Allow
@BDAIaddinAssismnt Publiz Yes Allow
@BDAIEddinAssismnt Publiz ‘es Allow
@BDAIaddlnAsslsmnt Publiz Yes Allow
@BDAIaddinAssismnt Publiz Yes Allow
@BDAIEddinAssismnt Publiz ‘es Allow
@BDAIaddlnAsslsmnt Publiz Yes Allow
@BDAIaddinAssismnt Publiz Yes Allow
@BDAIEddinAssismnt Publiz ‘es Allow
BDAppUpdater Publiz Y3 Allow
@BDAppUpdab&r Publiz Yeg Allow
@bduashreport.exe Publiz ‘fes Allow
bdcrashreport.exe Publiz ‘fes Allow
bdcrashrepaort.exe Domain  ‘Yes Allow X
4| | e »
[Mew Rue. .. [

Figure 52: Add inbound rules
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3. Select Port, and then click Next, as shown in the following figure.

* New Inbound Rule Wizard

Rule Type
Select the type of firewall rule to create.

@ Protocol and Ports
@ Action
@ Profile
@ Name

Figure 53: New inbound rule wizard
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Select TCP.

Select Specific Local ports.

Enter 80 next to Specific Local ports.
Click Next.

N o g A

* New Inbound Rule Wizard x|
Protocol and Ports

Specify the protozols and ports to which this rule applies.

Steps:

& Rule Type Does this nule apply ta TCP or UDP?
« Protocol and Ports @

@ Action DP

@ Profile

@ MName

Leam more asout protocol and ports

<gack || Mea> Cancel

Figure 54: Protocol and ports
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8. Select Allow the connection, and then click Next.

* New Inbound Rule Wizard x|

Action

Specify the action to be taken when a connection matches the conditions specified in the rule.

Steps-
& Rule Typs What action should be taken when a connection matches the specified condtions?

Protocol and Ports

(3

3 S les conn that are protected with |Psec as well as those are not
@ Profile
N " Allow the connection if it is secure
@ Hame This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in IPsec properties and rules in the Connection Security
Rule node.

Customize...

" Block the connection

Leam more sbout actions

< Back MNext > Cancel

Figure 55: Action
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9. Select all three checkboxes and click Next, as shown in the following figure.

* New Inbound Rule Wizard

Profile
Specify the profiles for which this rule applies.

Figure 56: Profile
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10. Enter Web under Name.
11. Click Finish, as shown in the following figure.

* Hew Tnhound Rule Wizard i _ x|

Name
Spacify the name and deecription of thie ruls.

Slhegrs.
@ Rule Type
@ Producul and Puils
@ Action
o Profilc L
[Weh
& MName
Description (npfional)

<gack  |[ EBsh | Concel

Figure 57: Name
After you click Finish, the following figure is displayed.

* Windows Frewall with Advanced Security

Fie Acen Ven i
#3703 Bz

i et

0

Y Sutbourdwes
B Ovrecion SecrtyRues -
B ¥ Mg AL m
= @m‘.ll.utww{:}u:f.\,kxl]n:rl}a'ﬁllmn‘.. Joven = ton Mo YALUS.. Ay
@W}S!ﬂfﬂ._., Frodicsrput Fa0essr... Joen Y= thn Mo BPATE.. Ay
@'&Fm.’i!mz.“.’{ﬁﬂrﬂrmJTP«m... Tman ¥a3 e M WRITE.. Aoy
@acxipes e Vi the Mo Cifrog. Ang
@acston: abie  vs s o ZPror.. AN
CEB0A UDF Port nbe  ts the o y tny
-3ir File Yanager Joten s (AT g Ay
[ T wan Vs [T [ S

Figure 58: Inbound rules added
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Adding outbound rules. Double-click Outbound Rules and right-click it again.
Repeat the steps for adding inbound rules to add outbound rules. The following

figure indicates that you have successfully added outbound rules.

* Wiindows Firewall with Advanced Security

fie Acs wiew I

29 70> Bl

L oo

11 Incourd ks
Cutho =

ou-d 2z
B Cornscton Searty 2 b

@ %, vowtnrg o= Nikrorang - —
= o2 Netinorang - Pachet Teo Siz (1IHPYE- Coran  Yec
@ Co tietmring Parzmcter oben (V.. Coran  Yes
i+ Neticndng - Trns Eirspded (IOPG6-. Coran s
@In-\l:w A Tes
@hisken I
Ehisem ' Yes
Ehinw o Y5
@I’thulhq -Cetnelion Jreahebe (IOP... Cown  “es
Eretnovking - Parsmete- Srobier (TP 4C0t) Coran  Yes
Eretnzting -Rediect DOVPe< Ot Doran  Yes

Figure 59: Outbound rules added

Close dl the windows once you are finished.

Mowe
How
Mo
Alow
How
Sow
How
How
How
Alow
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Testing the web server 1. Open Internet Information Service (11S) Manager as described before.
2. Select Application Poolsin the left panel, as shown in the following figure.
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g a0 This g et yous vies s manage the It of apgikcaton poks cn the server, Agplcation ok e associated it wosker processes, conlsin one o more Set Appication Podl Cefaults.Lo
o ardp different Application Pool Tasks
=8 Defeult Web Site Fdtar: Go = (ghshow Al | Groupbyr tie Groupng B chart
O Mame = | status Imﬁm | Manoged Ppi... | tdentty | Appheations | ® =
PRSP IET w40 Started Integrated ApdcatinPuolden... 0 < Recyde...
L} ASPNET 4.0 Classic Started 4.0 Classic mwmnm ] PR
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Figure 60: Application pools

3. Confirm that the parameters of SLWeb in the right panel are correct:

= Theversion of .NET Framework should be 4.0 (or aversion consistent
with what is installed).

= Managed pipeline mode should be Classic.

If the parameters are something else, you can double-click the entry to
modify them.
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4. Click SLWeb in the left panel under Sites.

TSL3000B installation

5. Click Browse*:80 (http) in the right panel, as shown in the following figure.
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Figure 61: SLWeb home

TekSmartLab User Manual

47



TSL3000B installation

Windows will automatically open Internet Explorer to http://localhost/. You can
also enter http://localhost/ or http://127.0.0.1/ in the address box of your Web
browser to visit the web page.

The following figure is the web page displayed.

P
& hitp://localhost P - %O talhost
M

Lab Name: TekSmartLab

Bench:

M [ [
Course Name: Scope Tutg M= fom webpege

Exersise: Rise and fall tim

I, Vleaseinput bench number!

Student Name:

| oK

Student ID:

[JRemember me
Scope Snapshot

Figure 62: TekSmartLab web page

This web page indicates that the TekSmartLab web server works fine. (You can
ignore the caution message in the figure above. When you visit the web page
using a QR code, you will not see this message.)

If you are not able to visit the web page, please refer to 11S installation and
configuration (See page 27, lISinstallation and configuration.) and confirm that
1S is properly configured.
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General information
Home page = The TSL3000B home page is shown asin the following figure.

Telitronix Teksmartlob

TekSmartLab

4+ Instructor

Exercise Material
Course Scope tutorial
o
Exercise  Rise and fall time meas = a

Report Template

Total Instruments
40 Bench Normal
Emor

Disconnected Test Repont

Figure 63: Home page
1. Themenu bar: Menus alowing you to configure the software.

2. Course and exercise information: Controlsto create and configure the courses
and exercisesin this area, as well as other related settings.

3. Configure instruments: Configure the instruments in batch by clicking this
area

4. Test report: View the test report submitted by students by clicking this area.

5. Lab information: Monitor and modify the parameters of instruments on
certain bench by clicking this area. Displays the bench status and instrument
status in the lab.
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Menu bar
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Click Home on the menu bar to return to the main page.

Change language. Click Setting -> L anguage on the menu bar to change the
software language, as shown in the following figure.
Telitronix TekSmarilab™ Heme  Selting Administrater About

Language
denchiLab L

+ Instructor Tekt

Saved Config Exercise Material

Course Scope tutorial

Exercise  Rise and fall time meas - Configure

Instrument

Report Template

Total Instruments
Normal
Emor

Disconnected Test Report

Figure 64: Change language

Lab general information. Click Setting -> General Information on the menu bar
to change the lab general information.

Telitronix TekSmarilab” Home Setting Administrator About

Exercise Material

Exercise  Rise and fall time meas ~

1
|
|
|

Report Template

Total Instruments
Norrnal
Emor

Disconnected Test Report

Figure 65: General information
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The following figure is displayed after you click General Information. You can
change the lab name in the upper part of the page.

Telironix TekSmarilak” Home Sefting Administrator About

General Information

Lab irife

Figure 66: Edit general information

Change the password. Click Administrator -> Change Password on the menu
bar to change the password, and the following dialog box is displayed.

Telitronix TekSmarilob Home Setting Administrator About

TekSmartLab

+ Instructor Tektronix

Course Scope tutorial

Exercise  Rise and fall time meas -

Configure

Instrument

Bench

Test Report

Figure 67: Change password
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Teltronix TekSmarilob

+ Instructor

Course

Exercise

Home Seting Administrator About

TekSmartLab

Tektronix

Scope tutorial

Rise and fall time me:

oK Cancel

Total Instruments
MNormal
Emor

Disconnected

Figure 68: Input new password

Input the old password, the following dialog box is displayed. The default
password is “admin”.

Configure

Instrument

Test Report
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. NOTE. In July 2017, the license policy and nomenclature was changed for
License Management 1 qrartl ab™ software.

The legacy system, with TSL3000B, will continue to be supported in the software,
SO you can use your current activation code when upgrading to the latest version
software.

The new application license, with TS_.3000B-FL, offer floating licenses (FL) that
can be checked in and out of the Tektronix Asset Management System on the
Tektronix.com Web site.

How to purchase. Contact your local Tektronix Account Manager to purchase
TSL3000B-FL. After purchasing, you will receive an email listing the options
purchased with the URL to the Tektronix Asset Management system that will
enable you to manage your licenses.

You can manage your licenses using the Tektronix Asset Management System
found athttp://www.tek.com/products/product-license.

The Tektronix Asset Management system provides an inventory of the license(s)
in your account. It enables you Check-out or Check-in alicense and view the
history of licenses.

How to install. Click About -> License M anagement on the menu bar and the
following figure is displayed.

Tol.ronix TekSmamias”  Home Seffing  Administrabor  About

< TekSmartLab

Figure 69: Install license
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Click the Install License button and browse to the location where the license file
islocated. Select the license file and click Open. After the successful installation
is finished, the software is listed in the table.

Figure 70: License install finished

How to move the license to a different host. You can return the license purchased
and assign it to a different host on the other computer. TSL3000B-FL isa
floating license, and it can be returned unlimited number of times and assigned
to adifferent host.

In order to move the license to a different host, follow these steps:

ClickAbout > License Management and select the license to return and click
Remove.

Figure 71: Select a license to remove
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Browse to the location where you would like to place the exit file (for example, a
network drive or a USB memory stick), and click Save to generate the exit file.

Telivonlx TekSmorilab® Heme  Seming A

Figure 72: Export the license file

Login to your account on TekAMS (Tektronix Asset Management system) and
upload the exit file. Once the license is returned successfully, it can be re-assigned
to a computer with different host.

About. Click About -> About on the menu bar to display the software
information, as shown in the following figure.

Tekironix TekSmarilab™ Home Settng Administrator About
TekSmartLab

+ Instructor T

Course

Exercise R

Em

Disconnected

Figure 73: Software information
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Lab instrument management

Configure bench and lab

56

layout

This part describes how to manage the instruments in the lab more effectively

with TekSmartL ab.

You can click Setting > Bench/Lab L ayout Config to
the bench layout.

Tekironix TekSmarilab Home Sefting Administrator About
Lai

itLab

=+ Instructor Tektronix

Exercise Material

Report Tamplate

Figure 74: Bench/Lab layout configuration

set the lab layout aswell as

Configure

Instrumant

Tast Report
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Bench layout setting
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The following figure is displayed when you click Bench/Lab Layout Config.
The Bench Layout Configuration tab is chosen.

Telitronix TekSmarilab” Home Sefing Administrator About

Bench Layout Configuration
Bench Layout

Examp[é ' Example

-123.125 mV bt
Example o ~IRX@Mple

OFF

Figure 75: Bench layout configuration tab

You can choose the bench layout templates in the Bench Layout Configuration
tab. The Four-instrument layout template is chosen by default, as shown above.

You can click the arrow in the upper right corner of the square representing each
instrument to choose the type of the instrument, as shown in the following figure.
Scope represents oscilloscope, AFG represents Arbitrary Function generator,
DMM represents digital multimeter, and PWS represents power supply.

Telitronix TekSmartlab Home Sefting Administrator About

Bench Layout Configuration

Bench Layout -]

Example Example

Example Example

Figure 76: Choose the instrument type
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The following figure shows the bench when four instruments are chosen.

Telidronix TekSmarilol Home Setting Administrator  About

Bench Layout Configuration
Bench Layout =

Examplé Example

Figure 77: Instrument chosen

You can click Apply in the upper right corner of the page to apply the settings to
all the other benches in the lab.

A dialog box for you to confirm is displayed. Click Yes, the bench settings are
applied to all the benches in the lab.

If you try to apply the settings without choosing the instruments, a warning
pops up.

Lab layout setting ~ Select the Lab Layout Configuration tab, as shown in the following figure.

Lab Layout Configuration

Figure 78: Lab layout configuration tab
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You can arrange the layout by input the number of rows and columnsin the Lab
Layout Configuration tab.

You can number the benches by rows or columns. The benches are numbered
by rows in the figure below.

You can double-click a bench to delete it, as shown in the following figure. You
can also double-click the blank to add the bench back.

Telitronix TekSmarilob

Lab Layout Configuration

Numbear &R Row =

Figure 79: Arranging benches

NOTE. If you switch between numbering the benches by row and by column, the
adding and deleting done previously will be canceled.
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You can also select Manual to number the benches manually, as shown in the
following figure.

Tekironix TekSmarilob

Lab Layout Configuration

Number Row -

1

Figure 80: Number the benches manually

Make sure you don’t number two benches with the same digit, or the following
warning pops up.

Telaronix Teksmartiaot
Lab Layout Confguration

Numbeor Row ¢

4

Figure 81: Two benches numbered the same

You can click Apply in the upper right corner of the page to apply the settings.

A dialog box for you to confirm the setting is popped up. Click Yesto complete
the lab configuration.
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Centralized instrument  You can configure the instruments and then distribute the settings to up to 100
configuration ~ benches.

Configuring instruments. Take the following steps to configure the instruments:

1. Click Configure Instrument pane on the home page. The following figure
is displayed.

< Back  Status Unselected [TT] Selecte Configure succeed Configgure fail Unselectable

Bench Selection | 1 2 3 ] 7 B 8 10 " 12

Figure 82: Configure instruments

2. Click theicon of an instrument to select it, and the following figure is
displayed.

Figure 83: Instrument selected
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3. Set the parameters of the instrument selected.

NOTE. If you tick Default Setup, the instrument will be reset. Make sure you
leave all the parameters unconfigured.

If you tick Default Setup and configure some parameters, the instrument will be
reset and then the parameters will be configured.

NOTE. The parameters that can be set are based on the first such instrument
connected to the software. For example, if the first oscill oscope detected by the
system is two-channeled, the parameters for CH3 and CH4 cannot be configured.

4. Click the white arrow on the right side of the Bench Selection bar to collapse
it, and the following figure is displayed. The numbered bench iconsin blue
is selectable.

Configure succeed Configure fail Unselectabie

All

=2
uty Inverse

Figure 84: Select bench
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5. Select the bench icon and click Apply on the upper right corner of the page,
and the following figure is displayed. The numbered bench icon displayed in
green means the bench is successfully configured. If the icon turns red, select
the bench and repeat the configuration. If the icon stays red, please check the
cable connection, and then restart the instruments and TBX3000A. If the fault
is still not cleared, please perform a self-check of the instrument by referring
to the instrument user manual.

< Back  smns Unsalecied | Setacted Configure succeed Configure fail Unselectabia

Bench Salaction

[s] [7] [&] [2] [=] &

(=] [z]

]
g Inverse

36

Figure 85: Bench configured

6. You can aso click Capture to get the configurations from a configured bench
to distribute to other benches.

NOTE. If two of the same instrument types are placed in the same bench, the
configuration of one instrument will be applied to the other.

It is recommended that the same instrument types that are connected to the system
are of the same series, or even the same model. For example, if the system already
has configurations for CH3 and CH4 for oscilloscope, the configuration won't
succeed if one of the oscilloscope that is connected to the system is a two-channel
oscilloscope.
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Firmware upgrade. Take the following steps to upgrade the firmware:

1. Select Setting -> Firmwar e/Cour sewar e Update on the menu bar. The

following figure is displayed.

Telironix TekSmartlob™ Home Setting Adm

s

Bench Selection 1 2 3

Firmware / Courseware Upgrade

Figure 86: Firmware upgrade

2.

3
4.
5

Choose the instrument type.
Choose Firmware.

Choose the upgrade file.
Click Apply.
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Centralized instrument monitoring. Click the lab information area on the main
(Home) page. The following figure is displayed.

Lab Overview

Bench Status cnline | | Offiine Instrument Status

Figure 87: Lab overview

The status of the bench and instruments are represented by different colors, as
explained in the status bar in the upper part of the page. For example, in the above
figure, bench 1 isonline, and the four instruments of bench 1 are working.

You can click the bench to enter the bench page and monitor the instruments, the
following figure is displayed.

Defaut Setup

3.862uVvVDC

Figure 88: Bench page

For the MDO3000 oscilloscope, you can switch between two modes. Scope
(oscilloscope) and SA (spectrum analyzer), as highlighted in the above figure.

65



TSL3000B

66

You can monitor and control an instrument in detail by clicking the expanding
icon (highlighted in yellow box) in the upper right corner on the instrument pane.

Using an oscilloscope as an example, the following page is displayed after you
click the expanding icon. If you want to go back, click restore icon in the upper
right corner.

Bench1 >

Defaut Setup  AufaSet ¥ Sigle Runy

Vertical & Honzontal

Figure 89: Oscilloscope page

If you select Waveform, the waveform is displayed in real-time on this page.
If you select Screen, a snapshot of the waveform on the actual instrument is
displayed here. You can right-click on the waveform to saveit. You can click
Screen again to take another snapshot.

You can disable Autoset on the upper right side of the page to have the students
practice setting parameters manually for the experiment. The Autoset button
isdisplayed in gray if you disable the function. If you enable the function, the
Autoset button is displayed in blue. You can click the button to execute the
auto setting.
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Asshown in the following figure, you can set the parameters for the waveformsin
the Vertical & Horizontal part of the page.

< Bench1

ul Setup AutoSet ¥ Single

Figure 90: Vertical and horizontal settings

You can either input values into the boxes or click arrows or plus and minus
symbols to set the parameters. In addition, the highlighted number 1 in yellow,
number 2 in blue represents the V-position of the two channels; the highlighted
yellow arrow represents trigger level. You can drag these symbols to change
the values directly.

For the channels, DC is the mode of coupling, and 1X isthe value for attenuation.
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As shown in the following figure, you can also use cursors for measurements
on this page.

Bench1

Figure 91: Cursors
Use these steps:
1. Select the Source and Mode in the Cursor area.

2. If you select Time for the mode, cursors “a’ and “b” are displayed on
the waveform. Move the cursors and the measurement result is displayed
automatically in the box at the upper right corner of the waveform display.
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Asset management. You can select Administrator -> Asset Management on the
menu bar to manage the instruments. The following figure is displayed.

Telironix TekSmaniab Home Setfing Administrator  About

Asset Management

0160421 =

Figure 92: Asset management

You can set the parameters and then click Query to acquire the information
about the instruments. Then you can click Export to export the result as an
Excel document.
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Lab teaching flow management

70

Create and select an
exercise

This section describes how the TekSmartLab helps optimize lab teaching flow.

As shown in the following figure, you can click the plus symbol in the course
information area to create a new course. The dialog box pops up for you to input
the information.

Teluronix TekSmarlob” Home Selting Administrator About

TekSmartLab

Create a new exercise
4+ Instructor Tektronix

Scope b

Exercise  Rise and fall time v Cenfigure

Instrument

Test Repornt

Figure 93: Create a new course

You can input the name of the instructor, the name of the course, and the name of
the exercise, and then click Ok to save the exercise, as shown in the following

figure.

Tekironix TekSmarilob’ Home Sefting Administrator About

TekSmartLab

Creats 3 new sxercise

#+ Instructor Tektronix

Course

Exercise - fall t o
Exercise  Rise and fall time i Configure

Instrumeant

40 Bench Normal
=0

Disconnected Test Report

Figure 94: Create new exercise
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Savelrecall instrument
configuration
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You can select an existing exercise, as shown in the following figure.

Teltronix TekSmarilob™

Figure 95: Select an existing exercise

Home Selting Administrator About

TekSmartLab

Instructor Tektronix

e Scope ttorial

Exercise Material

Report Templats

Total Instruments

Disconnected

Configure

Instrumant

Test Repon

NOTE. You can delete an exercise by clicking Administrator > Exercise
Management. Only the administrator has the access for deleting exercises.

This function allows you to save instrument configurations, or to recall instrument
configurations.

You can click the Saved Config area on the home page to configure the
instruments and then save the settings. The following figure is displayed.

Figure 96:

Configure the instruments

Range
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As shown in the previous figure, all the instrument types that are supported by the
software are displayed here. You can configure all the instrument types here as
long as you tick the box in the left upper corner of each instrument type.

NOTE. The differences between configuring instruments on the home page and
here are that:

* The configuration can be done to four instrument types at the same time in
this page.

* The configuration can be saved here and recalled for later use.

NOTE. If two of the same instrument types are placed in the same bench, the
configuration of one instrument will be applied to the other.

You can set the parameters for the instruments as shown in the following figure.

Figure 97: Configure the instruments

NOTE. The parameters that can be configured are based on the first instrument of
the type that is detected by the system.

You can also select a preconfigured instrument in another bench and click
Captureto acquire its configurations to apply to the instrument you want to
configure. The waveform of the oscilloscope and arbitrary function generator will
only be displayed when you click Capture.

You can click Save to save the configuration for future use. You can also select
other benches to apply the configurations.
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Student access  This chapter introduces features that this software provides for students to access
the experiments on a webpage.

Generate QR codes for benches. The server generates a webpage for each bench
for students to access the exercise. The students can log in the webpage by
scanning the QR code generated for the webpage or the | P address.

Take the following steps to generate QR codes for the benches:

1. Select Setting -> General Information on the menu bar to generate QR
codes for the benches, as shown in the following figure.

Teldronix TekSmartlab Home Seiting Administrator About

General Information

Lab inf

Figure 98: Generating QR code

2. Settheserver IPin the TekSmartL ab network. You can choose WiFi, LAN, or
input the IP manually.

NOTE. The server should be set with static |P so that the address for each
webpage won't change.

NOTE. If computersfor studentsinstalled on the benches and TekSmartLab server
belong to the same campus network, then set the server IP asthe IP addressin
the campus network. Thus, the computers on the benches are able to access the
benchspecific IP address distributed by the server.
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3. Input the bench number. If you want to generate the QR codes in batch for
benches, tick Batch, and then input the bench numbers.

4. Input comments if necessary.
5. Click Print under the QR code preview to generate the codes.

You can paste the printed QR codes on their correspondent benches in the lab.

Accessing the webpage. Students can take the following steps to access the
bench webpage:

1. Connect your smart phone or computer to the TekSmartLab network. If you
are using the computer on the bench, and the bench and server are connected
to the campus network, then you are not required to be connected to the
TekSmartLab network.

2. Taking bench 1 as an example, scan the QR code, or input the address to log
onto the bench webpage. The following figure is displayed.

= I 1A
Lab Name: TekSmariLab |
Bench: 1
Course Name.  Scope tutorial l|
Exersise: Rise and fall time
measurement
Student Name:

Student ID:

Eiimaborien
Scope Snapshot

Figure 99: Log in to the bench webpage
3. Input your name and ID to log in the webpage.

NOTE. Your Sudent ID should be unique, whereas Student Name does not need
to be unique.

You can also take a snapshot of the oscilloscope screen by clicking Scope
Snapshot on this page.
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Exercise material sharing
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In the course information area, you can click the Exercise Material areaon the
main (Home) page to share the exercise material with students. The following
figure is displayed.

Exercise Material

Hame
TES10006-EDU-Osc loscope-DataShent-1_0 pot SR04 N29M . plt

Figure 100: Edit exercise material

On this page, you can add or delete exercise material on the server.

Exercise Material

dd the matenal here so that the students a: ad it from the web page of their devices:

Figure 101: Add or delete exercise material
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On a student’s smart device, as shown below, students can download the exercise
material to their devices.

[i=]Test Repont g

I - ST_AFG_Cursor_Rise-Fall-Time_Measurement.p

I - TBS10008-EDU-Oscilloscope-DataSheet-1_0 pdt

Figure 102: Download exercise material

Test report editing  Inthe course information area, you can click Report Template button to import a
test report template to the server. You can create a test report template by using
Microsoft word (only .docx format is supported) and then import the .docx file to
the server, as shown in the following figure.

Test Report Template

Text and image can be saved e Text and image can be saved

: . 1 REVOLUTION, = kst
ARG * o] — e SERING. =m

Header and footer cannot be wd ® Header and footer cannot be saved

. ® Inserted equation, as below, cannot be
Inserted equation, as below, cannot be.
saved uniess it is changed to be an saved unless it is changed to be an image

(x+a) = '2;(:) xFank

Figure 103: Importing test report template

The template is transformed into an HTML file once it's imported to the server.
You can click Preview to see how it is displayed in HTML format.
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On a student’s smart device, as shown in the following figure, students can create
anew test report by clicking New Report.

[{=]Test Report

T Material

Figure 104: Create a new test report

When you create a new test report on your device, the defined template is
automatically loaded, as shown in the following figure.

‘=|Test Report _'_5-!'-'-"P~|:11¢'.-nal [

Tl Scope Image

. ® EEXE 3B
=~ |l = FontFamiy~ FontSizes~

I

m» ¥

Text and image can be saved

T e

Header and footer cannot be saved
Inserted equation. 83 below. cannot be
saved unless it is changed to be an image

Figure 105: Create a new test report
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You can edit the report and insert the test result. For example, click Scope Image
to insert the oscilloscope snapshot into the test report, as shown in the following
figure.

Figure 106: Scope snapshot inserted
After you are finished editing the test report, you can click Submit to submit it.
You can aso download the test report locally to edit it in aWord file.
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You can click Test Report on lower right side of the home page to check a
student’s test reports. The following figure is displayed.

Test Report

Export Report List Expor Report Files

Figure 107: Query test report

You can input the time next to Start and Stop and click Query to get the students’
report.

You can double-click areport to check it, or choose a report and click Detail to
check it.

You can click Export Report List to export the query result in an Excel document.
You can click Export Report Filesto export al the text reports.
You can click Delete to delete the selected report.

79



Case Study

Case Study

Set up a TekSmartLab network system

Introduction

80

In order to ensure the stability and security of running the TekSmartLab solution,
we should set up an independent network other than taking advantage of the
existing network, for example, the campus network. If the lab server is connected
to the campus network, we should add a network card or a USB WIFI dongle
for TekSmartL ab network. Thus the server is working simultaneously with the
TekSmartL ab network and the campus network.

The following figure illustrates that the server is connected to the TekSmartL ab
network through Wi-Fi, and also connected to the campus network through LAN.

\ |/ Campus
p
s P rmcsooon Network
- -_i_j TekSmartLab
Instrumenlsa«mbem: . Network

Figure 108: TekSmartLab

You can set up the TekSmartL ab network wireless, through cables, or a mix of
both according to the actual lab requirements.

NOTE. Make sure that TBX3000As on each bench are in the same network with
the server at all times, which means that you can ping the IP address of the
TBX3000As on the server successfully.
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Configure the network

TekSmartLab User Manual

To set up awireless network:

Configure the wireless network using these settings:

Wireless network mode: 2.4GHz, 802.11n

Set the number of the Max. Associated clients larger than the number of
devices that are connected to the network. For example, if the network is
connected to 1 lab server, 20 benches through TBX3000A, and 20 smart
phones from students, set the number of Max. Associated clients larger
than 41.

WIFI signal level: >=-50dBm (recommended)
WIFI signal to noise ratio: >=35dB (recommended)

For the wireless equipment:

If the number of benchesislarger than 15, it is recommended to use corporate
grade router (such as TP-LINK TL-R600VPN) plus Access Point devices
(such as TP-Link EAP120) to form a network. 1 AP for every 15 benches

is recommended.

If the number of benchesis equal to or smaller than 15, a corporate grade
router (such as TP-LINK TL-ER604W) is enough for the network.

NOTE. The WIFI coverage will vary by cases. Please consult with your IT
department or the router manufacturer for more information.

If you are going to set up awired network, make sure that every bench hasan IP
address. TBX3000A supports both dynamic |P and static IP.
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Install TekSmartLab on the lab server

Refer to Installing TSL3000B, (See page 8, Installing TSL3000B.) to install
TSL3000B properly on the lab server.

Note that the lab server should be set with a static |P address, and the software
should be started only after the lab server is connected to the TekSmartL ab

network.

Configure the TBX3000A

Connect the TBX3000A 1. Instal the USB-WIFI dongle on each TBX3000A.

2. Connect the instruments on each bench to the TBX3000A using USB cables,
and then power the instruments on, as shown in the following figure. The
figure is an example of only two instruments connected to the TBX3000A

on the bench.

Figure 109: Connecting TBX3000A
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Log onto the TBX3000A  There are two ways to log onto the TBX3000A configuration page on a computer:
configuration page

= Connecting the TBX3000A directly to a computer.
®  Connecting the TBX3000A to a router

Connect the TBX3000A directly to a computer. Connect the TBX3000A to a
computer as shown in the following figure:

Figure 110: Connect the TBX3000A directly to a computer

Set the LAN connection parameters of the computer (with path Control Panel >
Network and Internet > Network and Sharing Center for Win7 operation system)
according to the figure in the below:

e

2
Camtned Farusl Hiosmn a —_ . . ®
Whew your basic nebwork infosmation and sef up connections
[T WO p—— l& K e
-
Chirngen il gt el Thos commgeddar R Srtaven
Onange scbeannd thawng
g

|1 b CostraiPasl § Newick bl ka8 Mabuidh soel Uiimie) Cost

| 1. Local Area Connection

& @

tneraiiarany

s R e et | o 3. Internet Protocol I e
ey pe— Dk Cormectety: [ re—"

- "1 Version 4 (TCP/IPv4) © 0> o st
s Properties S e
2. Properties WE '_:“":m"f“"“"’""h__ o o e e o
, - e Wl —_——— 4. Select “Use the
""' - S e—— following IP address” and
= el e input the parameters

Figure 111: LAN configuration
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The LAN parameters are set as follows:
IP address ;- 192.168.1.66

Subnet mask: 255.255.255.0

Default gateway: 192.168.1.1

Enter the IP address 192.168.1.101 in your browser, and then configure the
TBX3000A.

Connect the TBX3000A to a router. Connect TBX3000A to arouter as shown

in the following figure:
. LAN cable

Router WIFI or LAN cable

Figure 112: Connect TBX3000A to a router

Make sure the computer is connected to the ‘school_lab_1' network. If the
computer is successfully connected via WIFI, you will see the network as shown
in the following figure.

Wireless Mztwork Connection ~ |
school_lab_1 Connected 1.5“_1 |
AuthorizedGuest ::“ |

TekSmartLab-Deme 1.1“

-

Open Metwork and Sharing Center

Figure 113: Computer connected to ‘school_lab_1’ network

NOTE. The ‘school_lab 1" network is generated by the router.
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Enter the IP address 192.168.1.101 into your browser, and the welcome page is
displayed as shown in the following figure. Then configure the TBX3000A.

<04 A 01921681101 ir| =

Welcome Page

Instnament Madel | TExa000A
LAN Configuration 1

Firmware Rievision: | 01.01.06_20150300
WIFI C - d

Serial Humber | CO000M
Sot Password I

LAM Conmection Status: | Connected

WF] Comnection Status. | Oscormeste

Host Name (FQDHN) | Banch1 lncal

Figure 114: TBX3000A welcome page

Configure the TBX3000A 1. On the welcome page of TBX3000A, Select LAN Configuration on the left
for the wireless network side to enter into LAN configuration page.

LAN Configuration

Welcome Page
e —
TCRIP Confguration Mode: Manual
e 1P Address: 152.188.1.901
Set Passwaord Subnet Mask: 265 255 2850
| Detault Galsway: w2651
| Connect Status: Cannesied
| Spaed: 100Mbs

Figure 115: LAN configuration

2. Click Modify to enter into Modify LAN Configuration page. Input “admin” if
password is required.

Madify LAN Configuration
Welcome Page
LAN Configuratien = :
i L Autormatic
e TCPIE Corfgurstion Moda, o ;
S [Cy— 6 A8 1 101
Subael haskc [msassassn |
Defaull Gatiway: 192.168.1.1
Hast Hame: [Bemnt |

Figure 116: Modify LAN configuration

TekSmartLab User Manual 85



Case Study

3. Change the host name into BenchX, in which X represents the number of the
bench on which the TBX3000A is placed. The above figure uses Benchl
as an example. Click Submit to finish. Note that the TCP/IP configuration
Mode and other settings should not be changed.

4. Click WIFI Configuration on the left side to enter into WIFI configuration

page.
G-\-__. CIy £ = & || & Wi Contigurstion 13
WIFI Configuration
Welcome Page
LAN Configuration Hostnarme: Bench1
- | TCPAP Configuration Mode: Manual
WIFI Configuration P Address
Set Password Subinet Mask:
Defaull Gateway:
S5ID;
Connect Status: Disconnacied
Signal Imensity:

(Lot ] [ scmar )

Figure 117: WIFI configuration
5. Click Scan AP to search for the WIFI network, as shown in the following

figure.
== =
[ ttpe 180, 388, 1. 101/ [
< Q90 & 01921681101 &l =
WIFI AP List 1
- 5510 B5SI0 Strength Security
unm
TekSmanLat-Demo W75.90.29.20.52 il WRA-PSHITKIP
WiF| Configuration
0P 1 DanaherTM 6880-ABD2T5AD al WPAZ 802 1W/AES
5 AuthorisedGuest 68-80:AB.02.75:44 al Hene ¥
O AdhonzedGuest 68 HO.AH D275 A2 o Hone
66B0-AB D2 TS A1 a WPAZ-802 1W/AES
COG11EB0A4C06 a WPA-PSKWPAZ PSKIAES
[ @  school lab 1 50 B0 5F 37 58 88 ol wn-mmu.nswnsq
O schoal lab 2 50805 37:68:10 a WPAPSKWPAZ PSHIAES
i leksmantiab-ty COE118:B0:5300 l Hone:
tichnal-smartlab 52 B0-5F S3B3 50 F Hena
DanaherTM BUALETIE4A B0 a WPAZ-02 TWAES
JS2108 L0 ormiSenp ool

Figure 118: Scan AP
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6. Choose school_lab_1, and then click Apply.

7. 1f the‘school_lab_1' network can only be accessed by a password, a prompt
pops up as shown in the figure below. Enter the password and click Connect.
Once connected, the WIFI indicator on TBX3000A will blink twice atime.

_—'~ i

) hinoyfesid. 168 1 208/

< Q20 % [102168.1.101

Wifi - config
AN S5I0 schoal_lab_1
mm Security Type WPAPSK -
Sot P " Encryption Type AES =
PSK Key teksmartiab
(Lcommeet ] (_Beex )

Figure 119: Input password

8. Check the Host Name, SSID and Connect Status, and TCP/IP configuration
Mode is Auto as default.

 —

WIFI Configuration

‘Welcome Page

Tan Hostname: Bencht
TCRIIF Genfiguration ode At

Tozond IF Addirss 1921851150

Set Pasaward Sukinal Mask 255325.255.0
Do Gabeway: 10218811
S5I0; sehaol_lab_1
Connect S2abss: Connected
Signal Intensity: Excellert

) (R

Figure 120: WIFI configuration
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9. If you need to set the static IP address, click Modify. Enter “admin” if
password is required. Select TCP/IP Configuration Mode to be Manual, and
set the |P address, Subnet mask and Default gateway manually. Click Submit
to finish. Note host name should not be changed.

Welcome Page
LAN Configuration
WIFI Configuration
Set Password

Figure 121: Modify WIFI configuration

Modify WIFI Configuration

TCPAP Configuration Mode

IP Address

Subnet Mask

Default Gateway:

Host Name

Automatic
* Manual

1921681111

255 255 256.0

19216811

Benchl

Submit

10. Click Welcome Page, and the configuration is done as shown in the figure

below.

[

‘Welzome Page
LAM Configuration
WEFI Canfi gurstian

581 Password

Figure 122: WIFI configuration finished

m
Welcome Page
[strumers podet
Fhmmwarne Redson

Feerinl Mumber

TEX30004
2.00
COIQEFT

| LAN Cermesbon Stalus
WIFI Comnecon Status:

Cormpcind

Comnected

Host Nama (FODNy

Banchi loral

11. Disconnect the LAN connection of TBX3000A to finish the configuraiton.

12. Repeat the procedure to configure the TBX3000A on the bench and change its
host name as BenchX, in which X represents the number of the bench that
TBX3000A is placed.

13. After configuring the TBX3000As, they will be connected to ‘school_lab 1’
network automatically, and will be automatically recognized as the bench
configured by the TSL3000B software running on the lab server.
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NOTE. The host name of TBX3000A must be changed on the LAN configuration
page.
Two TBX3000As cannot have the same host name, otherwise the later host name

will be displayed as* BenchX-2.local” , as shown on the welcome page below, and
cannot be recognized by the TS.3000B software.

Welcome Page
Walcome Page

Instrument Model TEX30004
LAN

Firmware Revision: 200

i i Serial Number: CO10677

ot Password LAN Connection Statis: Connected

WIFI Connecbon Status. Connec! bed
Host Mama (FQDN) Benchi-2 lacal

Figure 123: Two TBX3000As with the same host name

89



Case Study

90

Configure the TBX3000A
for the LAN network

1. Select LAN Configuration on the left side and click M odify, as shown in the
following figure. Input “admin” if password is required.

E|I e ﬂ

LAN Configuration
._W Hoshame Bencht |
TCRIP Configuration Made: Manssal ]
WIFI Configuration P Address 192168t 101 I
Set Password Subnet Mask: 765 255 255 O l
Default Gateway: 192 168 l |
Connecl Status. | Connecled !
Speed 100MBs |

Figure 124: LAN configuration

2. Change the host name of the bench to which the TBX3000A is connected, as
shown in the following figure.

Modify LAN Configuration

Whelcome Page

LAN Configuration & 5
TERIP Configrirason hode: £ ulomalin

WIF| Configuratian | | R

Set Password !IFMU%S'
| Subnet Hask: Ema —
i Default Gatewy: [ —]
| Host Marme. |Benchl l

Figure 125: Modify LAN configuration

3. Sdlect Automatic next to TCP/IP Configuration Mode. Or you can select
Manual, then input the | P address, subnet mask, and default gateway.

4. Click Submit to complete the configuration.

NOTE. After clicking Submit, the TBX3000A could be disconnected to the
computer that is used to configure the TBX3000A because the default |P address
of the TBX3000A is modified. To check the IP address and host name, you need to
log in the router configuration page.
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Arrange the bench and lab layout

Arrange the bench layout

TekSmartLab User Manual

This case supposes that there are four instruments placed in one bench: an
oscilloscope, an arbitrary function generator, a digital multimeter, and a power

supply.

Take the following steps to arrange the bench layout:

1. Click Setting -> Bench/Lab Layout Config and choose the Bench L ayout
Configuration tab.

2. Choose the four-instrument layout, as shown in the following figure.

Bench Layout

Figure 126: Four-instrument bench layout

3. Choose the four instruments, as shown in the following figure.

Telitronix TekSmarilab Home Setting Administrator About

Bench Layout

Example

Example

Figure 127: Choosing instruments
4. Click Apply.
5. Click Yesto confirm the setting.
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Arrange the lab layout  Inthis case, there are 16 benchesin 4 rows. The benches are numbered from left
to right, as shown in the following figure.

g & &
£ &
R 8- &

[
w

Q- & & &

8- &

q
{

Figure 128: Lab layout
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Take the following steps to arrange the lab layout:

1. Click Setting > Bench/Lab Layout Config and choose the L ab L ayout
Configuration tab.

Choose By Row next to Number.
Input 4 next to Row.

Input 5 next to Column.

o &~ W N

Clear the middle column by double-clicking the benches, as shown in the
following figure.

Tekironix' TekSmarilab Home Setting Administrator About

Bench Configuration Lab Layout Configuration

Mumber By Row Row 4 Column &

AFG | DMM

Figure 129: Arrange lab layout
6. Click Apply to complete the setting.
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Centralized instrument 1. Click Configure Instrument on the home page, the following page is
configuration displayed.

Figure 130: Configure instrument

2. Choose Scope in the left pane, the oscilloscope configuration page is
displayed on the right.

Click the white arrow to hide the icons of the instruments.

3

4. Tick Default Setup.

5. Click on CH2 to disable it, and its color will turn grey.
6

Choose Disable next to Autoset, as shown in the following figure.

Configure succeed Configune fail Unseiectabia

Figure 131: Configure oscilloscope
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7.

Click the white arrow to see all the benches, as shown in the following figure.

Bench Selection

Figure 132: Bench selection

8.
9.

10.

Choose al the benches displayed in blue, or click All to choose.

Click Apply to distribute the configuration to the chosen benches. The
configured benches will be displayed in green.

Press the Autoset button on the oscilloscope, and you will get a message that
“Autoset is disabled.” on its screen.
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Monitoring a bench

Checking the status of an
instrument

96

Click the lab information area on the main page. You will have an overview of
the lab.

Using bench 1 as an example in the following figure, al the four instruments are
connected and online.

1

SCOPH AFG | DMM

PWS

Figure 133: Instrument status

If you disconnect the oscilloscope from TBX3000A on bench 1, or turn its power
off, the scope will be displayed in grey.

1

SCOPH AFG | DMM

Figure 134: Scope not online

If you connect the oscilloscope to TBX3000A or turn its power on, the scope will
be displayed in green again.
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Monitoring a bench

TekSmartLab User Manual

You can click the bench to enter the bench page and monitor the instruments, the
following figure is displayed.

Bench1 >

Figure 135: Monitoring a bench

If you turn the horizontal scale knob of the oscilloscope on bench 1, you will see
that the waveform is also changed here.

You can monitor and control an instrument in detail by clicking the white box
in the upper right corner on the instrument pane. Using the oscilloscope as an
example, the following page is displayed after you click the white box.

< Bench1 >

Figure 136: Monitoring an oscilloscope

If you select Screen, a snapshot of the waveform on the actual instrument is
displayed here. You can right-click on the waveform to saveit. You can click
Screen again to take another snapshot.
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Controlling an instrument

98

from the server

Inthelab, if astudent requires some assistance from the instructor, the instructor
is able to access the instrument from the server to help the student.

Select Wavefor m, the waveform is displayed in real-time on this page, as shown
in the following figure.

Bench1

Figure 137: Monitoring an oscilloscope

Modify V-scale of CH1 on this page, the V-scale parameter is changed on the
oscilloscope accordingly. The waveform on this page and on the monitor of the
instrument are both changed.

If you place the mouse on top of the yellow arrow 1, an upward arrow and a
downward arrow are displayed. Right-click to select them and move them. The
V-position parameter on the oscilloscope is changed, as well as the waveform, as
shown in the following figure.

Benchi >

Dot Scbap AtoSiot ¥ Single Run

Figure 138: V-position changed
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Asset management
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On the home page, you can select Administrator -> Asset Management on the
menu bar to manage the instruments.

You can set the parameters by inputting time next to Start and Stop, and then
click Query to acquire the information about the instruments, the following figure
is displayed.

Tekitronix Teksmartlab® Home Setting Administrator  About

Asset Management

201604-11 = 2016-04.21 =

Figure 139: Query the instruments

All the instruments that are connected to the TekSmartL ab server are displayed,
including their bench number, serial number, models, and working duration.

Then you can click Export to export the result in the format of Excel.

99



Case Study

Create a new exercise

On the home page, you can click the plus symbol on the left upper corner of
the course information area to create a new exercise. The following figureis

displayed.

Create a new exercise

Instructor

Course

Exercise Demao|

Cancel

Figure 140: Create an exercise

You can input al the information and then click OK.

Now you can go to the exercise by selecting the instructor, as shown in the
following figure.

Telironlx Teksmartiat’

+ [nstnelor 1
Tekironix
Professo

Exsrcisa Matarial

Report Template

Figure 141: Selecting an instructor
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Instrument configuration saving/recalling

Take the following steps:

1.

2
3.
4

Select Tektronix next to Instructor.
Select Scope Tutorial next to Course.
Select Rise and fall time measurement next to Exercise.

Click the Save Config area.

NOTE. You may find that AFG and Scope are already selected with some
parameters configured. You can directly apply these parameters or configure
them by the following steps.

5.

Select the AFG and Scope by ticking the white box in the left upper corner of
each area, as shown in the following figure.

Measurement

Figure 142: Select Scope and AFG

TekSmartLab User Manual
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6. Configure the AFG and Scope, as shown in the following figure.

< Back St

Bench Selection 1

Figure 143: Configure Scope and AFG

7. Click Save after the configuration. This configuration is saved under this
exercise.

8. Click the white arrow to see all the benches, as shown in the following figure.

Bench Selection

Figure 144: Apply to other benches

9. Select the benches to be configured.
10. Click Apply to apply the configuration to all the selected benches.
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Student access

This case uses bench 1 as an example. The student visits the webpage of bench 1
through the computer on bench 1 or his or her own smart device.

Bench webpage  For theinstructor to create access for the bench webpage, take the following steps:

1. Select Setting -> General Information on the menu bar, as shown in the
following figure.

Telitronix TekSmortlob’ Home Setting Administrator About

General Information

Figure 145: Generate bench webpage
2. Input the server IP:

= If the server and the student computer on the bench are connected to the
same campus network, input the server |P address in the campus network.

= |f the server and student’s smart device are both connected to the
TekSmartLab network, input the server |P address in the TekSmartLab
network.

3. Select Single. The QR code and web address for the bench are shown in
the QR Code Print Preview area.
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For the student to access the webpage, you can:

B Typein the address in the computer web browser.

B Scan the QR code with the smart device.

m  Typeinthe addressin the web browser of the smart device.

The following figure is displayed after you type in the address in the computer
web browser. You may bookmark this page.

m B hep 1521600 B8 lagin s deckid=
L Tektropix ..

Lab Name: TekSmartLab

Bench: 1

Course Name: Scope tutorial

Exersise: Rise and fall time measurement
Student Name:

Student (D

emomoerme
Scope Snapshot

Figure 146: Visiting bench webpage

Sharing exercise material

In the course information area, you can click Exercise M aterial button to share
the exercise material with students. The following figure is displayed.

Exercise Material

Figure 147: Share exercise material
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You can click Add to add one or more files to share with the students, like
instrument reference manual or exercise videos, as shown in the following figure.

Figure 148: Add exercise material

For the student to access the exercise material:

1. On the bench webpage, input your name and ID.

NOTE. Your student ID should be unique, whereas the student name does not
need to be unique.

2. Select the Material tab, the exercise materials are displayed as shown in
the following figure.

. -
m | © hitp://192.168.1.66/CoursemwarelView aspx

© File Fdit View Favorites Toole Help

=] Test Report gV ECUEY _

IA ST_AFG_Cursor_Rise-Fall-Time_Measurement pdf

I‘- 1B51000B-EDU-Oscilloscope-DataSheet-1 0. pat

Figure 149: Access exercise material

3. Select thefile and click Download.
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Test report editing

106

For an instructor to edit the test report template:

1. Inthe courseinformation area, click Report Template button. The following

figure is displayed.

Test Report Template

o Textand image can be saved. e Text andimage can be saved

u
4 REVOLUTIOM g i s

VOLUTO R — B

® Header and footer cannot be saved. ® Header and footer cannot be saved

® Inserted equation, as below, cannot be
S 5 |eled Sq0MICHL B3 Lk, SN bae saved unless it is changed to be an image

saved unbess i is changed 1o be an image.

(x4+a) = i;(:),.a..._

Figure 150: Edit report template

2. Click Preview to check the existing template.

3. You can also create your own template and click the = import it to

the server. Only the *.docx file format is supported.
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For the student to edit and submit the test report.
1. Select Test Report tab on the webpage.
2. Click New Report, the following figure is displayed.

£~ iﬁ 2.1 P-cl @02168166

ﬂ T8 Edit View Favorites Tools Help

Create New Report 'l

Report Name

Rise and fall time me x

OK || Cancel

Figure 151: Create a new report

3. Click OK, the following figure is displayed. The report template created by
the instructor is loaded automatically.

= R I ——
B o= oo | v ]

o H® EX3A N A-N- romfemiy- Foiam~ B f == E~

Test Report Template

® |nstructor: Tektronix
® Courser: Scope Tutorial
® Exercise: Rise and fall time measurement

Student name:
Student ID:

OBJECTIVES s
Aftar narfaaminn 1his lah avartisa_lsamet wil ha shia 10

Figure 152: Edit new report
4. Edit the report by entering the name and ID, along with other content.
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5. Under Test Result, click Scope I mage button to insert scope snapshot, and
the following figure is displayed. The student ID is watermarked on the

oscilloscope snapshot.

F=iTestRepon oy Materiad |3

b M e E E ¥ B A - N - FodFamly- FonlSies= B J
I 251 ResSuUIL
Rididse

Figure 153: Scope snapshot inserted

6. Click Submit.

7. Click Download to download the file and unzip it so that you can edititin a
word document, as shown in the following figure.

ditinrad files

| Rise and fall tirne messurement htmi

Chouse default progra.

Figure 154: Open the test report on the computer
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For the instructor to query and check the test report.

1.

Click Test Report on lower right side of the home page to check student’s
test reports.

Input the time next to Start and Stop and click Query to get the students
report, the following figure is displayed.

Test Report

Detail Export Repor List Expait Repor Files Delete

Figure 155: Query and check test report

3.

Double-click areport created by the student, or choose a report and click
Detail to check it.

Click Export Report List to export the query result to an Excel document.
Click Export Report Filesto export all the text reports.
Select the report and click Delete to delete the report.
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Campus Level TekSmartLab

When one |lab manager must manage multiple labs, it can be a challenge to
manage al of the instruments efficiently since the lab manager needs to spend
time visiting each of the different labs. With campus level TekSmartLab, the
lab manager can centrally control and monitor the instruments in different labs
remotely from his own office.

Renchd

Bench 3

Benwh 2

G are

Beneh 3
. N
Banch 2, b

T
Tanh ".m:!ooun o T';".;;.’,'.‘,;;

Network

Office of lab

manager

Figure 156: Campus level TekSmartLab network diagram

110

As shown in the example above, TekSmartLab systems are setup in each of the
labs and the lab servers are connected to alocal area network, such as a campus
network. TekSmartL ab software isinstalled on the lab manager's computer, which
is connected to the same local area network. When the IP addresses of lab servers
and lab manager computers can communicate with each properly, lab manager
can access to the lab server in certain lab, and centrally control and monitor the
instruments in that lab remotely.

Here isthe process to setup campus level TekSmartL ab through a campus network
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For lab server in a specific Refer to Installing TSL3000B to install TSL3000B properly on the lab server,
lab (See page 8, Installing TS_3000B.).

2. Start TSL3000B TekSmartLab software, and click Setting -> Remote Lab
configuration on the menu bar.

3. Select | P address, which should be the IP of lab server when connecting to
campus network.

4. Set Allow Remote Control to be Yes, and set the Access Password, for
example “123", and click Save to finish.

Telivonix Tekmarilabr  Home Seming  Adminisirater  About

anfiguration

Figure 157: Remote lab configuration interface on the lab server

For lab manager computer 1. Refer to Installing TSL3000B to install TSL3000B properly on the lab
in the office manager computer, (See page 8, Installing TSL3000B.).

2. Connect to campus network, and check the communication with lab server
through pinging the lab server IP.

B CAVWindowshSystem32\PIMG.EXE

Figure 158: Pinging lab server IP from lab manager computer

3. Start TekSmartL ab software on the computer and click Setting -> Remote
L ab configuration on the main interface.
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4. Click Add and input the | P address and Access Password of the lab server
to be connected.

Telaronlx rexsmantab Home alor About

Remate Lab Confiquration

Figure 159: Remote lab configuration interface on lab manager computer

5. Select the added lab server 1P address and click Connect. It takes up to one
minute to finish, and the status will be changed to Connected once succeed.

Telironix Teksmoron Home Settng Administrator  About

Remaote Lab Configuration

Figure 160: Connect to lab server from lab manager computer
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6. Onthe main interface, switch between different labs via arrows.

Tolronix Tekimolal  Homa  Seming  Adminisiatr  About

< TekSmartLab

Figure 161: Main interface on lab manager computer

The interface will be shown with yellow boarder when connecting to alab server
remotely.

Figure 162: Connecting to a lab server remotely

NOTE. Even with atrial version software, lab manager can control and monitor
the instrumentsin different labs remotely. However, if lab manager wants to export
asset information and test reports of a lab remotely, it is necessary to purchase a
license (TSL3000B-FL) to active the software on lab manager computer.
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Previous software version installed

If the previous version of TSL3000B is uninstalled, but you can’t install the new
one, take the following steps:

1. Uninstall the previous version and restart the computer.

2. Find the TekSmartLab folder in C drive.
= For 64 bit, the directory is C:\Program Files (x86)\Tektronix\TekSmartL ab
= For 32 hit, the directory is C:\Program Files\Tektronix\TekSmartL ab\

3. Copy the folder to another directory, and then delete the folder.

4. Instal the latest version of TekSmartLab software.

NOTE. Make sure that you copy and back up the data before you del ete the folder.

If you need to restore the data of previous version, please contact your dealer or
Tektronix sales representative. They will contact engineers from the production
line to assist you to restore your previous data.

Software can’t be displayed properly

After you open the software, the screen page can't be displayed properly, as
shown in the following figure.

nistrator Ancut

TekSmartlab

Figure 163: Screen page not displayed properly
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To modify the screen
resolution

To modify the font size

There could be two reasons for this problem:

m  Screen resolution: If the screen resolution is lower than 1366* 768, the

software screen page can't be displayed properly.

B Font isnot the right size.

1. Right-click on desktop and select Screen resolution.

2. Set the resolution to 1366* 768, as shown in the following figure.

Change the appearance of your displays

-

Figure 164: Set the screen resolution

3. Click Apply.

1. Right-click on desktop and select Personalize.
2. Select Display, the following figure is displayed.

. o
» Comrcl Panel & Al Control Pae e+ Disgplay

Figure 165: Set the font size

3. Choose Small-100% (default).

4. Click Apply.

5. Log off to complete the modification.
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TBX3000A configuration page can’t be logged in

Take the following steps to solve this problem:

Benches disconnected

TekSmartLab User Manual

1
2.

Restart the TBX3000A and the computer used to configure TBX3000A.

Check the LAN configuration of the computer to see whether it has the correct
IP address and gateway.

Check whether the TBX3000A is properly connected to the computer by
the LAN cable.

Check the LAN indicator of the TBX3000A to see whether it works properly.

NOTE. For steps 2 to 4, please refer to Configure the TBX3000A, (See page 4,
Configure the TBX3000A.) for more information.

5.

If al above stepsfail, try adifferent web browser or change the computer.

6. You can also try pressthe RESET button for 5 seconds on the TBX3000A to

reset it to factory default, and then configure it again.

In the TekSmartLab WIFI network, the TBX3000A is configured, but all the
benches are displayed as disconnected on the screen page of TekSmartLab
software. Below is an example showing that all benches are disconnected.

Figure 166: All the benches not connected

Take the following steps:
1. Host Name of TBX3000A must be changed on LAN configuration page.

If it is changed on the WIFI configuration page, press Reset button on the
TBX3000A 5 seconds to load its default setup and configure it again.

Check whether the Host Name of the TBX3000A connected to a certain
bench, such as Benchl is correct. The host name must be in the form of
BenchX, in which X means number of the bench.
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3. Check whether the WIFI indicator of the TBX3000A blinks twice at atime
to see whether it is connected to the WIFI network. If the TBX3000A is not
correctly configured, please refer to Configure the TBX3000A, (See page 4,
Configure the TBX3000A.) to configure it again.

4. Check whether the firmware of the TBX3000A isthe latest version, which
isV2.0.0 or above. If not, please visit www.tek.com and search using the
search phrase “TBX3000A firmware”. Then download the latest version and
upgrade the firmware.

5. Check whether the server is connected to the network before open the
software.

NOTE. Make sure that the server is connected to the network before you open
the software.

6. Check the TSL3000B version on the lab server. It should be VV3.0.0 or above.
If not, please search and download the latest version from www.tek.com.

7. Onthelab server, ping the | P address of the TBX3000A on a certain bench,
as shown in the following figure. You can get the TBX3000A IP address
from the router configuration list. If this does not work, check the network
configuration.

Pinging 192.168.1.151 with 32 bytes of data:
from 192.168.1.151: hytes=32 time=185ms TTL=64
from 192.168.1.151: bytes=32 time=41ms TTL=64
from 192.168.1.151: bhytes=32 time=59ms TTL=64
from 192.168.1.151: bhytes=32 time=12ms TTL=64

Ping statistics for 192.168.1.151:

Packets: Sent = 4, Received = 4, Lost = 8 (Bxz loss).
Approximate round trip times in milli-seconds:

Minimum = 12ms, Maximum = 1805ms, Average = 5S54ms

Figure 167: Ping TBX3000A IP address
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Unstable connection in a 15-bench or above WIFI network

In aWIFI network of 15 benches or above, the connections of the benches are
quite unstable, even though all the devices in the network are properly configured
with the latest firmware.

This problem is mainly caused by the WIFI network configuration. Take the
following steps:

1. Check the network configuration. Using 30 benchesin this example, it is
highly recommended the network is supported by 1 router + 2 APs. If it's
only supported by 1 router, it's possible that not all benches can be distributed
with an |P address.

2. Check the router and AP configuration on the router management page to
make sure that the router has enough IP resources. Set the number of the
Max. Associated clients larger than the number of devices that are connected
to the network. For example, if the network is connected to one lab server, 30
benches through TBX3000A, and 30 smart phones, set the number of Max.
Associated clients to be greater than 61.

3. Check the IP address of the server to make sure that the server is properly
connected to the network. If the IP address of the server says 169.X.X.X, it
means it is not assigned with correct | P address. Check the configuration of
the router and APs. You can connect the server to another AP and assign a
static IP address to it.

4. Onthelab server, ping the IP address of a known bench. If this does not
work, check the network configuration.
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Unstable connection in a 20-bench LAN network

InaLAN network of 20 benches, the connections of the benches are quite
unstable, even though all the devices in the network are properly configured.

This problem is mainly caused by the router configuration or the MAC address of
the TBX3000A.

For router Configuration:

1. Check the IP address of the server. If it's not correctly assigned, configure
it again.

2. Check the configuration of the router and make sure that all the benches are
properly connected to the router.

3. Onthelab server, ping the IP address of a certain bench. If this does not
work, check the network configuration.

For MAC address conflict:

4. 1If your TBX3000A is manufactured before May 2016, there might be an issue
of MAC conflict. Please contact Tektronix representative for instructions
on how to change the MAC address.
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Instruments are displayed disconnected

On the screen page of the software, the bench is displayed as connected, but
the instruments are displayed as disconnected. However, the instruments are
turned on and connected to the TBX3000A through USB cable. Below is an
example that TBX3000A on bench 1 is online, but the instruments on bench 1
are displayed as disconnected.

TekSmartLab User Manual
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Figure 168: Instruments on bench 1 displayed disconnected

Take the following steps:

1.

Visit www.tek.com to check the specifications of TSL3000B to make sure the
instruments are supported by TekSmartL ab software.

Check that the version of TSL3000B is the latest version V3.0.0 or above. If
not, please visit www.tek.com and search “TSL3000B”. Then download the
latest version and update the software.

Check that the firmware of TBX3000A isthe latest version VV2.0.0 or above.
If not, please visit www.tek.com and search “TBX3000A firmware’. Then
download the latest version and upgrade the firmware.

For AFG1000 and TBS1000B-EDU instruments, check that the firmware for
your instruments are the latest version. If not, visit www.tek.com to download
the latest version and upgrade them.

For oscilloscopes of the series TBS1000, TDS1000C, TDS2000C etc., check
whether their USB ports are set as computer mode, If not, press Utility->
Options — Rear USB port -> Computer, and then restart the instrument.

For DMM4000 series instruments, the RS232 port should be configured as
follows:

= Baud rate: 9600

= Polarity: None

= Data bit: 8 data bits

= Flow control: None

= End of life character: Carriage Return and Line Feed

= Computer and terminal Mode: Computer
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Instrument parameters are not displayed

On the screen page of the software, the bench and instruments are displayed as
connected, but the instrument parameters are not displayed or an error message
appears when you enter the instrument page.

This problem is mainly caused by the firmware of the TBX3000A or other
connected instruments. Or the connected instruments are not supported.

Take the following steps:

1. Check that the firmware of the TBX3000A is the latest version VV2.0.0 or
above. If not, please visit www.tek.com and search using the seach phrase
“TBX3000A firmware”. Then download the latest version and upgrade the
firmware.

2. For AFG1000 and TBS1000B-EDU instruments, check the the instrument
firmwareisthe latest version. If not, visit www.tek.com to download the | atest
version and upgrade the instruments.

3. Upgrade the firmware of the bench instruments to the latest versions, which
are available on www.tek.com.

4. Check the TSL3000B datasheet, to see whether the instruments are supported.

Students can’t log in the bench webpage

The students can’t log in the bench webpage either through bench computer or
smart device.

This fault can be caused by two reasons:
m |IS configuration on the server.

®  Network configuration of the bench computer or smart device
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For lIS configuration 1. On the server with the TSL3000B running, open aweb browser and input
the address of “localhost”. If the IS is properly configured, a“ please input
bench number” dialog box will be popped up and the following figure will
be displayed.

Fia Edt Yws Faectes Tosh  Help

Lab Name: TekSmartLab

Bench:

Course Name: Scope tutorial

Exersise: Rise and fall time measurement
Student Name:

Student ID:

Remenberne
Scope Snapshot

Figure 169: Localhost webpage

2. If thellISisnot properly configured, please refer to I1S Installation and
Configuration, (See page 27, |ISinstallation and configuration.) to check
every step of the configuration.

If the following error message appears when configuring the I1S, then the 80
port conflict is the fault.

Internet Information Services (I5) Manager &

I-"'-_-"-.I This Web site cannot be started. Another Web site may be using the
S# same port,

Figure 170: 80 port conflict
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Use these steps to clear the fault:.

1. Start Windows Task Manager (Ctrl+Alt+Del) to find which program is

using port 80.

2. Choose View -> Select Columns. The following figureis displayed.

18 Winciows Task Manager = B B
le Opbons View Help
Aophcanons | Frocmam | senvces | Performance | Hetwedang | Users

Sefect Process Page Columng

| Select the cobumrs that il apoear on B Process page of Task Manager.
= .
| 7 210 rocess Identfer)
| | (SO e
Sessen
7| cru Usage
U Tirm
Memary - Working Set
Hemary - Pesk Wadking 56
Mermaary - Wirking St Dt
| | 9] Memary - Srivate Workirg Set
Memary « Comet Size
Memary - Paged ool
Memary - Hon-paged ool
Page Pt
Page Fault Defts.
Base Priceity

sirestyl

| Shevs processes from ol users

| |Processes 106 CPULkage 5% Physicsl Memory: 51%

Figure 171: Window task manager

3. Select PID (process Identifier ).

Click OK.

4
5. Click Processes to display the programs with PID information.
6

Under Start >> All Programs >>Accessories, right-click Command Prompt

and select Run as administrator.

7. Input command “netstat -nao” and press enter to finish. (Note the space

between netstat and -nao)
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8. ldentify the PID that isusing port 80 (refer to Local Address as below) , and
find the program name in Task Manager. It is“Skype.exe’ in the example
below.

Ic Options  View Help

Imape Name
Searchindexer.exe
services.exe
Skype.exe

Skypel 20 Autnl ipdatelue. pye
ShypeC2CPNRSve.cxe
SMSS.exe

epociov.ene
SEVLEXRE
sniserur.exe
sqhwriter.cxe

Figure 172: Command prompt

FID
5276
620,
7328
TibH
2256
396
00
3960
5497
amn

Applications | Processes Eervices | Performance |Nclwuddﬂg ILF.’-UG

UserName  CPU  Memory (... =

SYSTEM L] 8,760 K
SYSTEM o0 4,384 K
byan1 0o 58,968 K
SYSTEM oo Q940K
MNETWO... 00 1,216 K
SYSTEM 00 300K
SYSTEM L] 3,516 K
NETWO... 00 1,040 K
NETWIL.. oo B IE7K
SYSTEM oo 1,328K

9. Uninstall the program that is using port 80 or change the port the program is
using. Thefollowing figure shows an example of changing the port that Skype.

& Skype™ - Dptions = |

B Genen Connection: St up how Skype connects to the intemnet
B Frives Use port | | tocmeaming sonnegions

[Tl Uz port 83 and 443 for sdtilisnsl meoming cornections
i

Automatic prowy detection =
A
L T x ~| Enabée prowy authentication

| Enable PR
o i

| Allaw. direct cannechans to yeur contacts oy 2]

- i
& .
[) ot
{1{4 Ach Dt

Other things you can do

sane cancel |

Figure 173: Changing port for Skype

10. Choose Tools -> Options -> Advanced -> Connection.

11. Unselect “Use port 80 and 443 for additional incoming connections’.

12. Click Save to finish.
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For network configuration

of the bench computer or

smart device, use these

126

steps

Check that the bench computer or smart device is connected to the same
network that the lab server is connected to.

Make sure that the server |P address is static.

Make sure that the | P address input in the TSL3000B general information
page is correct, so that the computer and smart device input the correct one to
be connected to the server.

If it still does not work, switch to another web browser.

The student can try to ping the server IP. If it does not work, check the
network configuration again.

TekSmartLab User Manual



